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Before you begin

Welcome to OrCAD
OrCAD offers a total solution for your core design tasks: 
schematic- and VHDL-based design entry; FPGA and 
CPLD design synthesis; digital, analog, and mixed-signal 
simulation; and printed circuit board layout. What’s more, 
OrCAD’s products are a suite of applications built around 
an engineer's design flow—not just a collection of 
independently developed point tools. GerbTool is just one 
element in OrCAD's total solution design flow.
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How to use this guide
This guide is designed so you can quickly find the 
information you need to use GerbTool. 

Symbols and conventions
OrCAD printed documentation uses a few special 
symbols and conventions.

Notation Examples Description
C+r Press C+r Means to hold down the C key while 

pressing r.

A, f, o From the File menu, choose Open (A, f, 
o)

Means that you have two options. You 
can use the mouse to choose the Open 
command from the File menu, or you 
can press each of the keys in 
parentheses in order: first A, then f, 
then o.

Monospace font In the Part Name text box, type PARAM. Text that you type is shown in 
monospace font. In the example, you 
type the characters P, A, R, A, and 
M. 

UPPERCASE In Capture, open CLIPPERA.DSN. Path and filenames are shown in 
uppercase. In the example, you open 
the design file named CLIPPERA.DSN.

Italics In Capture, save design_name.DSN. Information that you are to provide is 
shown in italics. In the example, you 
save the design with a name of your 
choice, but it must have an extension of 
.DSN.
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Related documentation
In addition to this guide, you can find technical product 
information in the online Help, online books, OrCAD’s 
technical web site, as well as other books. The table below 
describes the types of technical documentation provided 
with GerbTool.

This documentation component . . . Provides this . . . 
This guide—

GerbTool User’s Guide

A comprehensive guide for understanding and using the 
features available in GerbTool.

Online Help Comprehensive information for understanding and using 
the features available in GerbTool.
You can access Help from the Help menu in GerbTool, 
by choosing the Help button in a dialog box, or by pressing 
1. Topics include:

• Explanations and instructions for common tasks.

• Descriptions of menu commands, dialog boxes, tools on 
the toolbar and tool palettes, and the status bar.

• Error messages and glossary terms.

• Reference information.

• Product support information.

You can get context-sensitive help for a error message by 
placing your cursor in the error message line in the session 
log and pressing 1.

Online GerbTool User’s Guide An online, searchable version of this guide.
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ODN—OrCAD Design Network at 
www.orcad.com/odn 

An internet-based technical support solution. ODN 
provides a variety of options for receiving and accessing 
design and technical information. ODN provides:

• A Knowledge Base with thousands of answers to 
questions on topics ranging from schematic design 
entry and VHDL-based programmable logic design to 
printed circuit board layout methodologies.

• A Knowledge Exchange forum for you to exchange 
information, ideas, and dialog with OrCAD users and 
technical experts from around the world. A list of new 
postings appears each time you visit the Knowledge 
Exchange, for a quick update of what’s new since your 
last visit.

• Tech Tips that deliver up-to-the-minute product 
information in your email box. Stay informed about the 
latest advances, tips, and announcements on your 
OrCAD product.

• Online technical support via the Tech Support 
Connection. Use this service to submit technical support 
incidents online. Create submissions, upload files, track 
your incidents and add comments directly into 
OrCAD’s support database.

This documentation component . . . Provides this . . . 



Introduction

1

Welcome to GerbTool, the easiest, most powerful, and 
versatile CAM station available.

GerbTool provides a powerful set of Windows-based 
CAM tools, including a feature-rich and robust 
Gerber/NC editor for ensuring a seamless link between 
PCB design and manufacturing. GerbTool is designed to 
provide CAD/CAM professionals with the tools they 
need for complete control over their CAM databases. 
From visual verification to high-level CAM tools, 
GerbTool simplifies and automates your PCB layout post 
processing and pre-manufacturing tasks.

GerbTool’s consistent and intuitive graphical user 
interface, and programmable mouse buttons and function 
keys, allow you to focus on accomplishing tasks, rather 
than on the technical details of operating the software.
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Using this manual
This manual was designed to assist you in using 
GerbTool’s features. Chapter 3, Quick start is especially 
geared toward providing the information you need to 
become immediately productive. A prior knowledge of 
CAD/CAM concepts and your computer’s operating 
system is assumed.

GerbTool features
n Fast and easy to use.

n Unlimited file sizes.

n Accurate to 1/100 mil (.00001 in.).

n Fully automatic panelization and venting.

n Complete undo to beginning of session.

n Full design rule checking (DRC), including annular 
ring checking and stub detection.

n Snoman™ pad/trace filleting.

n Teardrop pads.

n NC drill optimizing, including step and repeat.

n Isolated pad removal.

n Automatic removal of silkscreen data from pads.

n Full support for true multilayer netlists, including net 
highlighting.

n Scalable check plots to HPGL, PostScript®, Laser 
printers, and all printers/plotters supported by 
Windows.

n Conversion of drawn pads to flashes.

n Macro language allows the addition of new 
commands.



GerbTool features

3

n Metric and Imperial formats supported.

n Photoplotter support includes extended Gerber, 
FIRE9xxx, EIE, BARCO DPF and IPC-D-350.

n Accurate display of power and ground plane 
composites.

n Allows aperture scaling to create soldermasks, 
shrink/expand traces, and so on.

n Ability to scale layers to shrink or expand the 
database.

n Merge a complete design or a single Gerber file into 
another.

n Import NC Drill, HPGL, or BARCO files.

n View up to 999 layers simultaneously.

n Handles over 4000 apertures in up to 999 aperture 
lists.

n Aperture list conversion tools allow the addition of 
custom aperture list converters.

n Easily created custom apertures and custom fonts.



Chapter 1    Introduction

4



Configuration

2

Unlike previous releases of GerbTool, this version does 
not require that you create a configuration file. Instead, 
use the Configure command from the Options menu.
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Color list file
When starting up, GerbTool looks for a color list file 
named COLOR.RGB. Once the color list file is found, 
GerbTool reads the available colors from a red-green-blue 
(RGB) color and name pair list, then reads a list of the 
currently chosen colors. The currently chosen colors are 
those presented whenever you select colors from within 
GerbTool (for example, flash and draw colors).

Figure 1 Sample color list.

# maximum 1024 colors available...
[RGB Color/Name pairs]
128   0   0
vga16red
  0 128 128vga16cyan
  0 128   0vga16green
245 245 245WhiteSmoke

.

.

.
255 250 240FloralWhite
253 245 230OldLace
250 240 230linen
250 235 215AntiqueWhite

# maximum 32 current choice colors...
[Choice Colors]
blue
vga16green
white
black
coral

.

.

.
SteelBlue
SaddleBrown
DarkSalmon
DarkOrange
DeepPink
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In order to help you get started quickly, this chapter 
provides a quick overview of GerbTool and its processes. 
A more comprehensive description for each GerbTool 
function is provided in chapters 4 through 8.
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Starting GerbTool
To start GerbTool, choose GerbTool from the Tools menu 
in the OrCAD Layout session frame.

Creating a new aperture list
GerbTool’s most basic function is to read a Gerber file into 
memory and display it graphically on your screen. An 
aperture list file describes the shape and size of all the 
apertures used in the Gerber file. GerbTool automatically 
reads aperture list files from Layout. 

Note Aperture list files are not required for extended Gerber, FIRE9000 
or EIE format Gerber files, as they are embedded in the Gerber file.

You can also create your own aperture list files. There are 
two ways to do this. The easiest method is to convert your 
CAD aperture list into GerbTool format. Therefore, if you 
have an aperture list that is in a format listed in the table 
on the next page, you simply specify this as your aperture 
list and GerbTool automatically converts it for you.

Note You do not need to convert aperture list files created by Layout (or 
by OrCAD PCB 386+).

If, on the other hand, you do not have a CAD aperture list, 
you can enter a new, non-existing filename when you 
specify an aperture list and let GerbTool create it for you. 
Although it will initially be empty, GerbTool creates new 
apertures as needed when reading in your Gerber file. 
You can then edit the aperture list, changing the shapes 
and sizes to meet the needs of your Gerber file.
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Converting a CAD aperture list
GerbTool provides aperture list conversion for most of the 
CAD and photoplotter aperture list formats in use today. 
The conversion process translates a CAD aperture list 
directly into GerbTool format, thereby reducing 
data-entry-related problems. Again, remember that you 
do not need to convert aperture files created by Layout. 
The following table shows the aperture list formats 
supported by GerbTool, along with the name of the 
Aperture Conversion Rule (ACR) file used for the 
conversion.

Table 1 Supported aperture list formats.

Aperture list format GerbTool ACR file

ALLEGRO allegro.acr

CADSTAR cadstar.acr

CADSTAR 2 cadstar2.acr

CONSULTEK consultk.acr

CSI csi.acr

CSI Report csirpt.acr

CSI V4 csi4.acr

DC-CAD dc-cad.acr

DC-CAD 2 dc-cad2.acr

EAGLE eagle.acr

EDT edt.acr

EDT 2 edt2.acr

EE Designer eed.acr

GraphiCode Report gcrep.acr

GerbTool Report gtrep.acr

HIWIRE hiwire.acr

IVEX ivex.acr
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Lavenir Report laviner.acr

Lavenir View view.acr

MASSTECK masstek.acr

McCAD mccad.acr

MENTOR mentor.acr

OrCAD Layout (up to v6.42) masstek.acr

OrCAD PCB II orcad.acr

PADS pads.acr

P-CAD pcad.acr

P-CAD V6 pcad6.acr

P-CAD V7/V8 pcad7_8.acr

P-CAD Report pcadrpt.acr

PRANCE prance.acr

PRANCE 2 prance2.acr

PROTEL 1.0 protel.acr

PROTEL pfw.acr

SCICARDS scicards.acr

SCICARDS 2 scicard2.acr

TANGO tango.acr

ULTIBOARD ultibrd.acr

UNICAD unicad.acr

VALID valid.acr

Table 1 Supported aperture list formats. (continued)

Aperture list format GerbTool ACR file
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When creating a design, specify your aperture list When 
creating a design, specify your aperture list normally. 
GerbTool converts it to the proper format automatically. 
Or you may select the Convert command from the 
Apertures menu and convert it prior to loading it into 
GerbTool.

To convert a supported aperture list to GerbTool format, 
select the Convert command from the Apertures menu, 
specify an input filename, then select the appropriate 
converter in the Convert Aperture Lists dialog box.

Figure 2 Convert Aperture Lists dialog box

Creating a new design
To create a new design, choose either Auto or Manual 
mode after you choose New from the File menu.

To create a design file automatically

1 From the File menu, choose New. GerbTool displays 
the Create New Design Wizard dialog box.

2 Enter a name for the new design in the Design Name 
text box, and specify a directory in which to create the 
design in the Design Folder text box, then choose the 
Next button. GerbTool displays the next dialog box in 
the Create New Design Wizard.

3 Choose Automatic, then choose the Next button. 
GerbTool displays the next dialog box in the Create 
New Design Wizard.

For more information about converting 
aperture lists, see Chapter 7, Command 
reference.
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4 Specify the path to the directory that contains the 
Aperture list files for the new design in the text box, 
then choose the Next button. GerbTool displays a 
dialog box informing you that the design has been 
created.

5 Choose the Finish button. GerbTool displays the Edit 
dialog box and includes a list of all the layers found in 
the directory.

6 If you are using Gerber 274-D format, enter an 
aperture list for each layer by selecting that layer from 
the list, then entering the aperture list file (*.APP) in 
the Aperture List field.

7 Choose the Edit button. GerbTool displays the Gerber 
format dialog box.

8 Select the appropriate format, m.n setting, and zero 
suppression, then choose the OK button. GerbTool 
returns you to the Edit dialog box.

9 Choose the OK button. GerbTool creates the new 
design according to your specifications.

To create a design file manually

To create a design file manually in GerbTool, the layers 
and aperture lists must be in standard Gerber 274-D 
format.

1 From the File menu, choose New. GerbTool displays 
the Create New Design Wizard dialog box.

2 Enter a name for the new design in the Design Name 
text box, and specify a directory in which to create the 
design in the Design Folder text box, then choose the 
Finish button. GerbTool displays the Edit dialog box 
and includes a list of all the layers found in the 
directory.

3 Enter a set of layers, and an aperture list for each layer 
in the appropriate fields.
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4 Choose the Edit button. GerbTool displays the Gerber 
format dialog box.

5 Select the appropriate format, m.n setting, and zero 
suppression, then choose the OK button.

6 Choose the OK button. GerbTool creates the new 
design according to your specifications.

Whether creating design files automatically or manually, 
GerbTool creates a design file named UNTITLED.GTD in 
the current directory. You can use the Save command on 
the File menu to save your design file under a different 
name.

Opening an existing design
Follow these steps to open an existing design.

To open an existing design

1 From the File menu, choose the Open command. 
GerbTool displays the Open Design dialog box.

2 Locate and select the design you want to open, then 
choose the OK button. GerbTool displays the Edit 
dialog box.

3 If necessary, make any modifications, then choose the 
OK button. GerbTool loads the appropriate files.

Note Layout automatically generates a design file when post-processing 
(*.GTD).
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Saving a modified layer
If a layer has been modified or changed, you are given an 
opportunity to save it when you select the Save, Save As, 
or Save All command from the File menu. 

Note When GerbTool displays a list of files to save, you must select each 
file you want to save. Only those files selected are saved.

Exiting GerbTool
To exit GerbTool, choose the Exit command from the File 
menu. If any layers have been modified, GerbTool 
requests confirmation that you really want to exit.



GerbTool basics
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This chapter provides information on GerbTool basics.
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GerbTool window

The GerbTool window consists of the following 
components:

n Main menu bar where you can “pull down” the 
command menus.

n Toolbars where you can choose commands with a 
single click.

n Settings control bar, where you control various 
program settings, such as metric display mode and 
grid snap.

n Color toolbars where you can change layer colors and 
visibility.

n Birdseye view that shows the current view window 
relative to the extents of the loaded database.

n Adjustable pane dividers to split the drawing area into 
multiple views.

n Drawing area where GerbTool displays all database 
items.

n Crosshair cursor indicating the position of the mouse 
within the drawing area.

Birdseye View

Layer Color/Visibility

Status Bar

Film Box

Drawing Area

Tool bars Menu bar Active Layer/Dcode bar

Coordinate display

Tool bars

Prompt area

Cross-hair cursorTool bars

Pane Divider

Pane Divider
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n Film box graphic that indicates the size of the current 
film box.

n Status bar with prompt area where GerbTool displays 
command messages.

n Tool tips on most window features including toolbar 
buttons, control bar buttons and menu items.

Toolbars
Each icon within a toolbar represents a shortcut to a 
command. When you click on an icon in the toolbar, 
GerbTool executes the command associated with that 
icon.

Settings bar
Use the settings bar to quickly and easily control various 
options with a single mouse click. This section describes 
each button on the settings bar.

Sketch  
This button toggles sketch mode on or off. When sketch 
mode is on, pads appear with an outline only, and traces 
appear as a single thin line. Besides speeding up redraw 
times, this mode can also help you spot stacked pads.

Overlay 

This button toggles overlay mode on or off. When overlay 
mode is on, items become transparent when drawn on top 
of each other. When overlay mode is off, items obscure 
whatever is drawn previously. Overlay mode makes it 
easier to spot stacked pads.
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View Composites 

This button toggles the way GerbTool displays composite 
layers (extended Gerber and FIRExxxx only). When View 
Composites is on, the polarity of each layer, specified by 
the Polarity field within the Edit dialog box (from the Edit 
command on the Layers menu), is honored. If a layer is 
specified “Clear,” all data on that layer appears with the 
current background color.

DRC Errors 

This button toggles the display of rule violation errors on 
or off. If DRC errors exist and this setting is on, GerbTool 
displays the DRC View Errors dialog box. 

Note For information on error reporting, see the DRC section in Chapter 
7, Command reference.

Grid 
This button toggles the system grid display on or off. 

Note For information on grids, see the Grid section in Chapter 7, 
Command reference.

Grid Snap 
This button toggles grid snap mode on or off. When grid 
snap mode is on, the crosshair cursor automatically jumps 
to the nearest grid point. 

Note For information on grid snapping, see the Grid Snapping section in 
Chapter 7, Command reference.
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Orthogonal Snap  
Use this button to toggle orthogonal snap mode on or off. 
When on, lines drawn interactively are forced to the 
specified angle.

Note The current setting can be temporarily overridden by holding down 
the C key.

Arcs 360°  

This button toggles the method of creating arcs used by 
the Arc and Circle commands (on the Add menu). If on, all 
arcs are created using 360° circular interpolation. If off, all 
arcs are created using arcs of 90 or fewer degrees. This 
does not affect the way Gerber data is read from a disk file. 
It only pertains to adding new arcs with the Arc command 
(on the Add menu) and the Circle command (on the Edit 
menu).

Metric 

This button toggles metric mode on or off. When metric 
mode is enabled, GerbTool shows all information and 
editing fields that represent sizes and distances (for 
example, coordinates) in metric format.

Active layer/D-Code
You can dock the active layer/D-Code control bar or 
allow it to “float” in a dialog box. Use this control bar to 
control the currently active layer and D-Code. To change 
the active layer or D-Code, simply use the drop-down list 
to select a different layer or D-Code.



Chapter 4    GerbTool basics

20

Coordinate display
You can dock the coordinate display control bar or allow 
it to “float” in a dialog box. It shows at a glance the current 
location of the crosshair cursor. The format of the display 
is controlled by the current setting of the Me button within 
the Settings bar or the Metric command on the Options 
menu and the file format of the active layer.

Color chooser bar
You can dock the color chooser bar or allow it to “float” in 
a dialog box. It is available at all times to change layer 
colors and visibility. When a layer is on, indicated by a red 
box around the layer number, it is both visible and 
editable. When a layer is off it is neither visible nor 
editable. When a layer is ref, indicated by a black box 
around the layer number, it is visible but not editable.

Birdseye view
You can dock the birdseye view or allow it to “float” in a 
dialog box. The black rectangle represents the database 
extents while the red rectangle represents the current 
viewing window. Use it to determine at a glance exactly 
where your current view window is located.

Split screen pane dividers
By adjusting the pane dividers, you can split the drawing 
area into up to four separate viewing windows. Each 
window represents a different view of your design. You 
can view and edit your data at multiple zoom levels or 
locations simultaneously.
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Drawing area
The drawing area is the area between the menu bar and 
the status bar. All database items are displayed here.

Crosshair cursor
While the mouse position is within the drawing area, 
GerbTool displays the cursor as a crosshair. The exact 
location of the crosshair cursor appears in the Coordinate 
Display toolbar described above.

Film box
The film box represents the size of the film on which you 
will plot, and is a graphic display only. It does not become 
part of your Gerber database(s).

Tip You can control the size and color of the film box using the Options 
menu’s Configure command, described in Chapter 7, Command 
reference.

Status bar
GerbTool displays command status and prompts in this 
area.

Tool tips
When you hold the mouse cursor over a toolbar button for 
a few seconds, a small popup window appears with a 
short description of the feature.
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Design files
GerbTool uses design files. A design file, as created by 
GerbTool (or Layout), contains information about the 
Gerber files, and their associated aperture list files, that 
constitute a single PCB. This usually includes filenames 
for inner and outer signal layers, silkscreen layers, 
soldermask layers, and so on. GerbTool also associates an 
operating environment with each design file. Thus, when 
you load an existing design file, GerbTool restores the 
environment to the state it was in when you last saved the 
design file. This eliminates the need to continually 
reconfigure GerbTool each time you load a design.

Note The default file extension for design files is configurable and is 
easily changed using the Configure command on the Options menu. 
Layout uses a .GTD extension for these files.

Aperture list files
Aperture list files define the characteristics of each Gerber 
D-Code used in a design. For each D-Code the aperture 
list file defines a shape, size, type, and NC drill tool 
number (see Chapter 7, Command reference). GerbTool 
stores aperture lists in ASCII format. This makes it easy to 
create and modify aperture lists. It also allows easy 
conversion from most CAD system aperture lists.

Note The default file extension for aperture list files is configurable. You 
can change it using the Configure command on the Options menu. 
Layout uses an .APP extension for aperture list files it creates.

For details of the aperture list format, 
along with an example aperture list, see 
Appendix B, Aperture list file format.
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Using GerbTool commands
This section describes the different ways to use GerbTool 
commands.

Mouse-button and function-key commands
GerbTool comes pre-configured with the following mouse 
button and function key assignments.

The assigned mouse and function key commands are 
available any time GerbTool is idle (for example, there is 
no command prompt in the prompt area).

Table 2 Mouse-button and function-key commands.

Key Assignment

Left mouse button View Window

Middle mouse button Zoom In

Right mouse button None

1 Redraw

2 View Film Box

3 View Previous

4 View All

5 Layers Edit

6 Aperture Edit

7 Aperture Report

8 Query Highlight

9 Query Item

0 Measure End to End

! Add

@ Remove
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Shortcut keys
Shortcut keys are available anytime GerbTool is idle, or 
when GerbTool prompts you to enter a point. Below is a 
list of the shortcut keys. GerbTool executes shortcut keys 
immediately without affecting the current command.

Table 3 Shortcut keys.

Key Action

J Enter coordinate at cursor 
location

h Snap cursor to center of item

u Zoom in

d Zoom out

l Scroll page left

r Scroll page right

t Scroll page up

b Scroll page down

+ or i Zoom in

- or o Zoom out

0-9 Bring a layer to the top (1-10)

C+0-9 Bring a layer to the top 
(11-20)

a Turn on all layers

C+a Turn off all but active layer

b Pop-up floating color box

c Enter absolute coordinates

C+c Enter relative coordinates

d Increment current D-Code

C+d Decrement current D-Code

C+f Edit configuration flags
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Key Action

C+g Edit system grid

h Toggle highlights on or off

l Increment active layer

C+l Decrement active layer

m Run macro

C+m Toggle metric mode

p Pan

C+p Toggle auto pan mode

C+A+q Quit immediately without 
confirmation

r Redraw

C+r View all

s Toggle grid snap

C+s Screen print

u Undo last edit

C+u Undo all edits

v Toggle composite viewing

C+v Toggle virtual panel mode

Table 3 Shortcut keys. (continued)
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Interrupting a drawing process
Anytime GerbTool redraws the display or highlights a 
window of data, you can halt the drawing process by 
pressing the E key or clicking the right mouse button. 
This does not affect the operation of the command and, in 
many cases, speeds up its operation.

Ending a command
You can end a command, or end at least one level of a 
multistep command, by pressing the E key or right 
mouse button.



Performance tips

5

This chapter provides tips for obtaining optimal 
performance from GerbTool.
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Speeding up GerbTool operations

Using shortcut keys
Shortcut keys are a powerful feature of GerbTool. These 
keys are available any time GerbTool is waiting for you to 
enter a coordinate (point) or whenever it is idle (that is, 
when no command has been selected). Using these keys 
you can snap to the center of a database item, change 
which layers are viewed, undo edits, and so on.

Interrupting, redrawing, and highlighting
You can speed up any command that redraws the 
database or highlights a group of items by canceling the 
drawing process. Click the right button or press the E 
key to halt the redraw. This doesn’t affect the operation of 
the command; it affects only the redraw. Once you’re 
comfortable with the operation of GerbTool commands 
you will find that this ability significantly speeds things 
up.

For a complete list of available shortcut 
keys, see Chapter 4, GerbTool basics.
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Undoing edits
The Undo command provides a high level of freedom 
when making database edits. You can experiment and try 
different edits without fear of data loss. Since undo is 
available as the shortcut key u, you can undo edits 
immediately without having to exit the current command. 
Undo works for all edits regardless of size, and there is no 
limit to the number of edits you can undo. Remember to 
enable the undo capability with the Configure command 
(Options menu) before making your edits, then use the Edit 
menu’s Undo command or the shortcut key u to undo as 
necessary.

Programming mouse buttons and 
function keys
GerbTool’s easy-to-use graphical user interface is further 
enhanced with the versatility of programmable mouse 
buttons and function keys. Using the Configure command 
on the Options menu, you can program the mouse button 
and function keys 1 through @ with commands that 
you frequently use. 
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Uses for GerbTool

6

This chapter provides several examples of uses for 
GerbTool.
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Layer alignment
Layer alignment involves lining up all layers so that when 
you view multiple layers simultaneously, they are 
correctly aligned. Proper layer alignment is also crucial to 
the successful creation of a multilayer netlist.

First select a master layer with which all other layers 
should be aligned and select an item on that layer to use as 
a reference point. Choose the Align command from the 
Edit menu and select the item you chose as a reference 
point. Then, select an item on each layer to be aligned that 
corresponds to the reference point. As you select each 
item, GerbTool aligns the all other layers to the master 
layer.

Tip You can use the shortcut zoom in, zoom out, and pan keys (see 
Chapter 4, GerbTool basics) to locate the reference and corresponding 
items.

Creating NC drill files
Use the Drill command on the Tools menu to create an NC 
Drill file from any layer. Choose the format for the drill file 
by choosing the NC Format button within the Drill editing 
dialog box (shown in Chapter 7, Command reference). Usually, the 
layer you choose to create a drill file from represents the 
pad master for the entire design. When creating NC Drill 
files, GerbTool translates the Gerber flashes (except 
targets and thermals) into drill “hits.” The Tool field, in 
the corresponding aperture list for the selected layer, 
determines the tool call-out for each drill hit.

Note Use the Report command from the Apertures menu to determine if 
you have a tool assigned to each flash. Edit the aperture list, if 
required, so all flashes are assigned a tool.

GerbTool then optimizes the drill hits, according to your 
specifications, for fastest throughput.
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Perform panelization prior to executing the Tools menu’s 
Drill command. If your drilling equipment has a small 
memory capacity, perform a “virtual” panelization. This 
allows GerbTool to insert the needed step and repeat 
codes into the output drill file. Preferably, if your drilling 
equipment has enough memory, you should perform a 
normal non-virtual panelization. This results in a fully 
optimized panel for the maximum drilling efficiency.

Importing drill files
Use the Drill command from the Import menu to load an 
NC Drill file into the active layer. Layout creates a drill 
file, THRUHOLE.TAP, that you can import in order to 
automatically include the drill information for your 
design. 

You can also create a new empty layer first by selecting the 
Create command from the Layers menu. Make sure that 
the layer you choose is the active layer.

When loading an NC drill file, GerbTool converts the drill 
hits into Gerber flashes. Each tool called out in the drill file 
is located in the aperture list for the active layer. If 
GerbTool can’t find a tool, it adds an aperture to the list 
with an “Unknown” shape and the correct tool 
assignment. You can then edit the aperture to correct the 
shape, size, and so on.

Note Use the Report command (from the Apertures menu) to determine 
if any apertures were added. Those added are highlighted.



Chapter 6    Uses for GerbTool

34

Panelizing
With GerbTool, panelizing is a simple, one-step process 
when using the Auto Panel feature. After activating the 
layers to be panelized (only), select the Panelize command 
from the Tools menu, ensure that the Auto Panel button is 
selected (shown in Chapter 7, Command reference), and enter the 
minimum image border-to-border spacing in the X and Y 
fields. The spacing you specify should be between 
adjoining edges of the intended images. GerbTool 
automatically calculates the maximum number of images 
that will fit inside the current film box. After asking for 
confirmation, GerbTool completes the panelization 
process. Depending on the setting of the Virtual button, 
GerbTool either copies the proper number of images into 
the database or notes the number of copies and their 
location for display purposes.

Note You can use the right mouse button or press the E key to stop 
the drawing process anytime during the panelizing process. This 
usually provides a noticeable improvement in the overall time to 
complete the panelizing process without affecting the finished 
panel in any way.

Viewing or printing Gerber 
274-D composite layers
You can use black and white for layer colors, to provide 
accurate viewing of composite power and ground layers. 
Setting the negative layer to white on a black background 
and the positive layers to black results in a realistic 
depiction of the final film.

Note The negative layer must superimpose the positive layer.
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To print a composite layer, view your composite layers as 
described above, then use the Print command (from the 
File menu). The printed image appears on the page exactly 
as it does in the display.

Note Since the image for printing is created in a high resolution 
off-screen bitmap, the film box and display grid may appear on the 
output page. You can disable this by setting the film box color to 
the background color using the Film box command (Options menu) 
and disabling the display of the grid using the Grid command 
(Options menu), or shortcut key G.

Merging designs
You can merge two or more designs into a single Gerber 
file so they can be photoplotted simultaneously. This 
reduces manufacturing costs by making full use of 
photoplot film.

In order to merge designs in this manner, the following 
conditions must exist:

n Each file must be in the same Gerber format and have 
the same m.n values, and zero suppression.

n Each file must use the same aperture list. That is, the 
size and shape of each D-Code must be the same in 
each aperture list.

n The respective layers in each design must be the same. 
For example, layer 1 of each design must be the 
silkscreen, layer 2 of each design must be the top layer, 
and so on.

To merge design files

1 From the File menu choose the Open command and 
select the .GTD file for the first design. GerbTool 
displays a list of layers in the Layers-Edit dialog box.

2 Choose the OK button. GerbTool displays the design 
at coordinates 0:0 in the lower left of the Film Box.

For information on Gerber formats, see 
the discussion of the File menu’s Format 
command in Chapter 7, Command 
reference.
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3 From the Edit menu, choose the Scale command. The 
Scale and/or Offset Layers dialog box appears. 
Choose the desired offset value.

4 Select All Visible from the Layers drop down list.

5 Choose the OK button. GerbTool responds with an 
error message: “Command cannot be undone. 
Continue?”

6 Choose Yes. This shifts the first design.

7 From the File menu, choose Merge and then choose 
Design. In the Merge Design dialog box, choose the 
second design. The second file appears in the film box.

Note OrCAD recommends that you merge only Gerber 274-D files.

Drawn pads
Occasionally, CAD systems may output an irregularly 
shaped or sized pad using multiple draws to “fill in” the 
shape, rather than a more efficient single flash. This 
results in larger Gerber files than necessary and increases 
processing times. Also, it is virtually impossible for 
high-level CAM tools such as DRC to recognize the drawn 

pads as true pads, rather than as collections of traces. The 

difference between a typical drawn pad and a comparable 

flash is shown below.

Figure 3 Drawn pad versus a flash.

Drawn Pad Flash
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The drawn pad in this example requires 27 separate 
Gerber commands to accomplish what one Gerber flash 
can accomplish. Thus, if you have 2000 of these drawn 
flashes, you’ll have a Gerber file with at least 54,000 lines 
when flashes could accomplish the same thing in only 
2000 flashes.

Using the Pads command from the Convert menu, you 
can convert all your drawn pads to flashes. You do this by 
identifying one occurrence of a drawn pad and allowing 
GerbTool to find all drawn pads that match. And, to 
increase GerbTool’s ability to recognize matching drawn 
pads, you can specify a tolerance value to compensate for 
some CAD systems’ round-off errors. By specifying a 
tolerance, you allow GerbTool to relax its criteria for 
determining matching drawn pads.

Tip Converting drawn pads to flashes should be the first thing you do 
to your designs. This usually ensures trouble-free conversion. Also, 
you must convert all drawn pads to flashes before generating a 
netlist or running most other CAM tools.

Automatic silkscreen clean-up
GerbTool has the ability to automatically clean up a 
silkscreen where lines touch or are too close to the pads. 
Using the Fix Silkscreen command from the Tools menu, 
you specify the layer(s) that the silkscreen and pad master 
are on and the minimum spacing that must be maintained 
between the silkscreen data and the pads. If you want, you 
can use window mode to clean up isolated areas rather 
than the entire silkscreen layer. GerbTool then cleans up 
all areas where silkscreen lines are too close to a pad. Each 
offending line is moved just enough to eliminate the 
violation.

For more information on silkscreen 
cleanup, and to see before and after 
illustrations, see Chapter 7, Command 
reference.
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Creating a soldermask layer
Creating a soldermask is a simple and easy process using 
the Scale command, from the D-Code selection on the Edit 
menu.

First, create the soldermask layer by copying the pad 
master layer onto a new layer. Use the Copy command to 
copy the pad master to the new layer. When copying, 
select Create Layer from the Copy to Layer fields 
drop-down list. This creates a new layer for the new 
soldermask data.

Now, select the Scale command, enter a scale factor for X 
and Y and select the Fixed Amount field in the D-Code 
Scale dialog box, then choose the OK button. GerbTool 
adds apertures to the corresponding aperture lists as 
necessary and replaces the D-Codes with the new scaled 
D-Codes. The original D-Codes within the aperture lists 
are not modified.
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Transcoding
Using the Transcode command (from the D-Code 
selection on the Edit menu), you can transcode (transform 
D-Code) item by item or by selecting a group. Using 
selection criteria, you can choose exactly which D-Codes 
are transcoded. For example, to transcode only draws 
with a D-Code of D18 on layer 4 and within a particular 
window, specify the selection criteria as shown in the 
following example:

Figure 4 Restrictive selection criteria.

After selecting and highlighting the D-Codes, GerbTool 
prompts you for the new D-Code and then performs the 
actual transcoding.
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Snoman pad and trace filleting
Snoman is a highly configurable dialog box that specifies 
a method of optimizing pad/trace junction points. This is 
often referred to as filleting or teardropping (see Appendix C, 
Snoman concepts for a technical description of Snoman). The 
purpose of Snoman is to increase your manufacturing 
yield by adding more copper in the area of the pad/trace 
junction, thereby eliminating any possible pad/trace 
separation. Snoman is used primarily when dealing with 
small pads and traces (such as micro vias in the 30 mils or 
less range) but can be used anywhere to prevent 
pad/trace separation. Snoman provides additional 
versatility by allowing you control of the size and location 
of the generated Snoman pads, along with an integral 
DRC to eliminate any possible spacing violations.

Note Trivia: Snoman derives its unusual name from the appearance of a 
Snoman pad placed on top of a host pad, which resembles a “real” 
snowman.

For a complete description of how to use 
the Snoman tool, see Chapter 7, Command 
reference.
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This chapter provides details for using each GerbTool 
command.
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File menu
The File menu selection displays commands for dealing 
primarily with files and directories. The menu commands 
are described in the following sections.

New 
The New command presents the New Design Wizard as 
shown below.

Figure 5 New Design Wizard.

Design Name
Enter a filename for the new design file.

Design Folder
Using the Browse button you can browse to the folder that 
contains the data files that you want loaded into the new 
design.
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Clicking on the Next button moves you to the next step 
and presents you with a choice of two modes: Automatic 
and Manual.

Automatic
When you select Auto mode, GerbTool builds a design file 
for you automatically. You specify the source folder and 
GerbTool determines which files are Gerber or aperture 
lists. The Gerber filenames are sorted first alphabetically, 
and then by layer number, if one is found. If an aperture 
list is found that is not already in GerbTool format, 
GerbTool tries each configured aperture list converter 
until a match is found. Finally, each aperture list is 
matched to a suitable Gerber filename. GerbTool then 
displays the Edit dialog box where you can make any final 
adjustments, if necessary.

Note This command is affected by the number of aperture converters 
configured and by the filename extensions that are ignored. In 
general, fewer aperture list converters and more ignored filename 
extensions result in faster performance.

Manual
When you select Manual mode, GerbTool creates an 
empty design file for you, and then displays the Edit 
dialog box for you to enter the Gerber files and aperture 
lists.

Open 
This command displays the file chooser and prompts you 
for a design file to load. You can use a wildcard 
specification to obtain a list of files from which to choose. 
After you specify a design file to load, GerbTool displays 
the Edit dialog box where you can define or modify the 
layer structure and, if needed, define or change the Gerber 
input format specification.
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Close
This command closes the current design.

Save 
Select this command to save the current design file, and 
optionally, any modified layers or aperture lists. This 
command does not close the current design; you can 
continue to work on it after saving. You must use this 
command, Save As, or Save All to save modified layer 
data.

Save As
Select this command to save the current design file under 
a different filename and optionally any modified layers or 
aperture lists. This command does not close the current 
design; you may continue to work on it after saving.

Save All
Select this menu item to save the current design and all 
modified layers or aperture lists. This command does not 
close the current design; you may continue to work on it 
after saving.
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Format
This menu selection has two commands: Gerber and Drill. 
When you select one of these commands, GerbTool 
displays a format dialog box in which you set the global 
formats for the file type in question.

Note GerbTool supports both global and local formats. Global formats 
apply to all layers that do not have a local format assigned to them. 
Use this command to edit the global formats only. See the Edit 
command in the Layers menu for more information on local 
formats.

Figure 6 Typical format dialog box.

You can specify the correct format for that type of file (in 
this example, Gerber) by changing the settings in a format 
dialog box. The illustration above shows a Gerber Format 
editing dialog box, which includes the following fields:

Dialect
Indicates the specific format of the Gerber language such 
as RS-274-D, extended Gerber, FIRE9xxx, and EIE. If in 
doubt, choose RS-274-D.
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m.n
Coordinate format such as 2.3. This specifies 2 decimal 
digits before an implied decimal point, and 3 following 
(for example, 12250 represents 12.250 if the coordinate 
format is 2.3). Because of limitations in the representation 
of arcs in Gerber format, it is best to use at least a 3.4 
coordinate precision for designs that include arcs.

Terminator
Indicates the block terminator (EOB). Use \r to indicate a 
carriage return (ASCII 13) and \n to indicate a line feed 
(ASCII 10).

Mode
Choose Absolute or Incremental (see Glossary for 
descriptions of these terms).

Zero suppression
Indicates whether leading zeros or trailing zeros are 
suppressed, or there is no zero suppression.

“G” commands
Indicates whether GerbTool includes “G” commands (for 
example, G01) when you output Gerber files.

Special
You can enable Modal compression to reduce the size of 
your files by removing all redundant draft codes and 
coordinates. Or, you can enable Metric mode indicating 
that your files are in metric format. You can also specify 
whether all circular interpolated arcs should be 
considered 360° or quadrant, enable the saving of G04 
comments, enable the output of UserData information, 
enable the output of Netlist information embedded within 
the Gerber file(s), and specify that carriage returns and 
line feeds should be honored as block terminators.
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You can toggle between metric and inch format, as well as 
change m.n formats after loading a design. If you change 
formats after loading, all layers are marked as modified. 

Note If you change formats after loading and do not save all layers, the 
next time you load that design, the saved format may not match 
that of the unsaved Gerber files.

Selecting the Netlist button tells GerbTool to save netlist 
information within the Gerber file. If you have previously 
saved a Gerber file with netlist information, you can 
remove it by deselecting the Netlist button and saving.

Note It is important that you specify the correct format before loading a 
new design. The critical format items are m.n, mode, and trailing 
zeros. If you load a design with an incorrect format, GerbTool will 
display it with unpredictable results. If you inadvertently load a 
design this way, reload the design and click on the Format button 
of the Edit dialog box to correct the format.

Merge
The Merge command has two modes: Design and Gerber.

Design
Selecting this command allows another complete design 
to be merged layer by layer into the current design. If a 
layer from the external design doesn’t exist in the current 
design, you will be prompted to create a new layer.

Gerber
Use this command to merge a Gerber file into the 
currently active layer. GerbTool prompts you for a 
filename. You can use a wildcard specification to obtain a 
list of files from which to choose. The specified filename is 
not added to the list of loaded layers. Rather, the contents 
of the file are read in and appended to the active layer.

Note All merge commands require that 
you ensure the critical format items 
(mode, m.n and zero suppression) of the 
file or files being merged match those of 
the currently loaded design.
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Import
The Import command has a number of options: BARCO 
DPF, HPGL, IPC-D-356, Drill and DXF.

BARCO DPF
Use this command to import one or more BARCO files 
into the currently loaded design. This command begins 
importing the specified files into the active layer if it is 
empty. If it is not empty, GerbTool creates a new layer 
following the active layer. GerbTool creates as many 
layers as necessary to import all the files you specify.

HPGL
Use this command to merge an HPGL plot file into the 
currently active layer. After selecting a file to import, 
GerbTool displays the following HPGL import dialog box.

Figure 7 HPGL Import dialog box.

Using this dialog box, you can specify the expected plot 
size, whether to rotate the plot data and which D-Codes to 
use for each HPGL pen.

Note Once a BARCO DPF file is imported 
into a layer it effectively becomes Gerber 
data and will indeed be saved as Gerber if 
the layer is subsequently saved. To output 
the layer in BARCO DPF format use the 
BARCO DPF command from the Export 
menu.
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IPC-D-356
Use this command to import an IPC-D-356 netlist into 
your design. Because an IPC-D-356 netlist contains 
information pertaining to pads and not traces, GerbTool 
must generate an internal netlist prior to importing an 
IPC-D-356 netlist, to ensure that your database contains a 
full and complete netlist after importing. While this may 
sound redundant, the added benefit of an “automatic 
netlist comparison” is well worth it. The netlist 
comparison feature produces a report file detailing any 
differences between the internal and the imported netlists, 
in addition to highlighting any differences. Optionally, 
you can update the database UserData fields with the 
component/net data from the IPC-D-356 file. Then, you 
can use GerbTool commands, including the Item Info 
command (on the Query menu), to examine and 
manipulate the true reference designators, pin numbers, 
and so on.

GerbTool creates a pad for each test point in the input file. 
These pads are based on the size and location of the test 
points and are placed on the active layer. It is a good idea 
to create an empty layer and make it the active layer 
before importing an IPC-D-356 file.

GerbTool converts the IPC information into Userdata 
attached to the pads and traces in the Gerber file. For pads, 
the format is “netname:component(pin).” For traces, only 
the netname is attached.

The list below shows possible error messages that can 
come from importing an IPC-D-356 file:

No IPC data for location 2.8750, 3.7500 
Layer:1

There is a pad on this layer that does not have any 
matching IPC information.

No Gerber data for location 1.5980, 4.3800 
ID 45:
() idx 43

There was an IPC-D-356 record for this location, but no 
Gerber data.
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Gerber Net Re-assignment: GerbTool net 78
Locations: 1.7980,0.8300 and 2.7980,4.2800
IPC nets 55:() 171:()

The IPC file has tried to associate the 2 nets, “55:()” and 
“171:()”, to the GerbTool net number 78.

IPC Net Re-assignment: GerbTool nets 123 
250
Locations: 2.0980,1.0300 and 3.7980,4.3800
IPC net 78:()

The IPC file has tried to give the same net information 
“78:()” to the GerbTool nets 123 and 250.

Drill
Use this command to import an NC Drill file onto the 
active layer. 

Note This command requires that you ensure the critical format items 
(mode, m.n and trailing zero suppression) for the file, or files, 
being loaded match those of the currently specified drill format.

DXF
Use this command to import a DXF file into your design. 
You can map each layer contained within the DXF file to 
one or more GerbTool layers. This flexibility allows you to 
duplicate information onto multiple layers. For instance, a 
pad master layer might need to be merged onto each layer 
containing traces.

Likewise, you can map more than one DXF layer to a 
single GerbTool layer.

You can map layers by color so that items of the same 
color are merged together onto a single GerbTool layer. 
This feature can be useful for viewing DXF files containing 
many colors or items that don’t share the same color as the 
DXF layer in which they appear.
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You can also map blocks to apertures manually, or 
automatically when you export from GerbTool, if you 
turn on the Auto Map feature. GerbTool automatically 
explodes blocks that you don’t map to apertures into their 

individual draw components.

Note Mapping blocks to equivalent apertures makes design editing 
easier and decreases the size of the database.

GerbTool supports standard SHX font files and SHX 

Unifont files, both for text and shape entities. If text within 

the DXF file refers to a font that is not present on your 
system, or the font file is of an unrecognized type, 
GerbTool uses a standard font in its place.

GerbTool displays the following dialog box.

Figure 8 Import DXF dialog box.

Input File
Specifies the DXF file to import.
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Report File
Specifies the report file to generate.

Font Directory
Specifies the directory for SHX font and shape files.

Source DXF Layer
Specifies the current DXF layer you selected for mapping 
to zero or more destination layers in GerbTool.

Destination Layer
Specifies the layers that you selected to receive the 
contents of the Source DXF Layer. Note that more than 
one destination layer can be selected by keeping the C 
key pressed during selection.

Map All to Current
Merges all DXF layers into the current GerbTool layer.

Map by Color
Select this to map DXF file items onto GerbTool layers 
based on color. Items of color 1 (red) appear on GerbTool 
layer 1, color 2 (yellow) on GerbTool layer 2, and so on.

Though many drawings use colors 1 through 9 only, the 
valid range is 1 through 255.

Map Sequentially
Displays a dialog box you use to sequentially map DXF 
layers to GerbTool layers. You can specify the first 
GerbTool layer to receive DXF layer information, and you 
can exclude DXF layer 0 from the mapping. 

Note Ensure that the Max Layers setting 
in the General Configuration Options is set 
high enough to allow for the highest color 
expected (255 maximum). Items of a 
color number higher than this setting 
appear on the last (highest-numbered) 
GerbTool layer. 
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Scale Factor
Specifies the scale factor GerbTool uses when merging. 
The default scale factor is 1. A design drawn using metric 
units may require that the scale factor be changed 
appropriately (e.g., if the units are millimeters, use a scale 
factor of .0394).

Line Width
Specifies the line width, in inches, GerbTool should use 
for zero-width lines. The default width is 0.01 inches.

Place at Origin
Specifies that GerbTool places the DXF design with its 
lower-left corner at the GerbTool origin.

Clear Merge Layers
Specifies that GerbTool empties all merge layers prior to 
importing DXF information.

Create Apertures
Specifies that GerbTool creates an aperture for drawing 
lines when an equivalent aperture does not exist. If not 
checked, GerbTool uses the next smaller aperture. If a next 
smaller aperture does not exist, it uses the smallest.

Map Blocks
Displays a dialog box that you use to map blocks in the 
DXF file to apertures in GerbTool. If Auto Map is selected 
then all blocks to be mapped must have their names 
constructed in the same manner as GerbTool DXF Export 
constructs block names. If Clear Map is selected, then all 
block mapping associations are removed.

Note Zero-width, closed polylines create 
filled polygons in GerbTool.
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Export
Using the Export command you can export your Gerber 
data into BARCO DPF, IPC-D-350, IPC-D-356, DXF, 
HPGL and PostScript data formats.

BARCO DPF
GerbTool exports designs in the BARCO DPF format to a 
separate file for each layer. You select which layers to 
export and what the output filenames will be. If you 
enable the Auto Rename button GerbTool outputs all 
selected layers, renaming each layer automatically using 
the filename extension specified in the New Extension 
field.

IPC-D-350
GerbTool exports designs in the IPC-D-350 format to one 
disk file, containing all layer data specified within the 
currently loaded design. The specified output file contains 
all data necessary to reproduce your design on any 
IPC-D-350 compatible device.

IPC-D-356
GerbTool exports designs in the IPC-D-356 format to one 
disk file containing all layer data specified within the 
currently loaded design. The specified output file contains 
all netlist data associated with the current design.

DXF
When exporting to DXF format, GerbTool creates a 
corresponding DXF layer for each layer in the GerbTool 
design. In addition it creates a DXF layer 0, containing 
items which appear within the Blocks section.
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The Blocks section contains blocks with information 
necessary for displaying each of the apertures used in the 
design. You are not required to acquire an equivalent set 
of blocks for reproducing the apertures that can appear 
within GerbTool. 

Note DXF does not support the concept of polarity. Negative polarity 
areas within custom apertures will not appear correctly when the 
file is imported into other applications.

Block names are created with a convention that allows for 
easy import back into GerbTool when the DXF Import 
Auto Map feature is used. Each pad in the design is output 
into the DXF file as a block insert. By processing the pads 
as references in this manner, instead of duplicating the 
draws for each instance, can significantly reduce the size 
of the generated file.

When exporting to the DXF format, you see the following 
dialog box.

Figure 9 Export DXF dialog box.

Output File Specifies name of the DXF file to create 
when exporting.

Report File Specifies the report file to generate.
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HPGL
GerbTool provides three modes of output when plotting 
on an HPGL compatible plotter: Sketch, Outline and Fill. 
Sketch mode is the fastest but does not show width on 
draws and some flashes such as Donuts. Outline mode 
shows true width on all objects but they are outlined only. 
Fill mode shows true width, and all objects are completely 
filled in as they would appear on a photoplot. Fill mode is 
the slowest and is extremely hard on plotter pens.

Figure 10Export HPGL dialog box.

You can also specify output file, media size, plot offset, 
pen width, pen speed, pen number for flashes and draws, 
pen number for the optional border, scale, whether to 
rotate 90° and whether to plot only pads (flashes). The 
offset values are applied independent of the scale 
specified. Plot offsets allow you to plot multiple images on 
one sheet.

Add Border This option adds a border to your plots. To 
control what text GerbTool adds to this border see 
Options/Configure later in this chapter for a description 
of the Print Border Text configuration parameter.
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Batch Mode This option instructs GerbTool to output 
each visible layer to a separate output file. During batch 
mode operation, if the Output File field is empty, the 
output filenames are derived from the filename associated 
with each layer and the currently configured HPGL 
filename extension (see Options/Configure later in this 
chapter). If, on the other hand, the output file field 
contains a filename, GerbTool appends a number 
representing the number of the input layer (i.e., demo.001, 
demo.002, and so on).

Interactive Mode Enabling Interactive mode allows you 
to interactively position each layer on the output page. To 
position an image on the page, simply click your mouse 
over an image to select it and then drag the image to the 
desired location and release the mouse button (or click 
again).

During interactive plot positioning, a menu of buttons is 
provided along with several plot specific nested 
commands.

Figure 11HPGL interactive control form.

The Plot button saves the page layout and plots the data. 
The OK button saves the page layout and quits the 
interactive session without plotting. The Reset button 
resets the images to their initial positions for this session 
(if the form has been pinned) or simply quits the 
interactive session without saving the page layout or 
plotting the data. 

The nested commands available during an interactive plot 
session are “C” for absolute coordinate entry, “I” for page 
layout initialization, “L” to cycle the currently selected 
layer forward, C+L to cycle the currently selected layer 
backward, “S” to snap (align) the currently selected layer 
on top of another layer, and “R” to redraw the page 
layout.
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Note There are two files within the GerbTool program directory that 
affect each HPGL plot. The files HPGL.INI and HPGL.DEI are 
prefixed and appended, respectively, to the actual plot output. If 
you have any special requirements, you may edit these files as 
needed.

PostScript
GerbTool provides PostScript output allowing you to plot 
your data on any device that supports PostScript, 
including typesetters capable of producing production 
quality artwork.

There are two modes of output when outputting 
PostScript: Outline and Fill. Outline mode shows true 
width on all objects but they are outlined only. This allows 
you to check for overlapping features. Fill mode shows 
true width, and all objects are completely filled in as they 
would appear on a photoplot. Fill mode may produce a 
larger output file.

Figure 12Export PostScript dialog box.

You can also specify output file, media size, plot offset, 
scale including fit to page, whether to rotate 90° and 
whether to plot only pads (flashes). The offset values are 
applied independent of the scale specified. Plot offsets 
allow you to position the image anywhere on the media.



File menu

59

Gray Scale    Enabling Gray Scale mode allows you to 
output accurate black and white composites, as well as 
halftone images. When Gray Scale mode is disabled, all 
colors other than the background color are printed as 
black. When enabled, all colors (other than black/white) 
are converted to a different gray scale.

Add Border This option adds a border to your plots. To 
control what text GerbTool adds to this border, see the 
Configure section under the Options menu later in this 
chapter for a description of the Print Border Text 
configuration parameter.

Batch Mode This option instructs GerbTool to output 
each visible layer to a separate output file. During batch 
mode operation, if the Output File field is empty, the 
output filenames are derived from the filename associated 
with each layer and the currently configured HPGL 
filename extension (see the Configure section under the 
Options menu later in this chapter). If, on the other hand, 
the output file field contains a filename, GerbTool 
appends a number representing the number of the input 
layer (i.e., demo.001, demo.002, and so on).

Page Setup
Use this command to configure how GerbTool will format 
each page printed by the Print command.

Figure 13Page Setup dialog box.
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Scale
Specifies the scale for the print output. A scale of “1” 
indicates a 1:1 correspondence between the print output 
and the design. A scale of “2” indicates a 2:1 
correspondence between the print output and the design, 
and so on. 

Overlap
Indicates the amount of overlap for pages of a multi-page 
plot, to allow for proper alignment when taping the pages 
together.

Add Border
This option adds a border to your print output. 

Batch Mode
This option instructs GerbTool to output each visible layer 
to a separate output file. During batch mode operation, if 
the Output File field is empty, GerbTool derives the 
output filenames from the filename associated with each 
layer and the currently configured Postscript filename 
extension (as explained in the Configure command 
discussion, later in this chapter). If, on the other hand, the 
output file field contains a filename, GerbTool appends a 
number representing the number of the input layer 
(demo.001, demo.002, and so on). 

Color/Grey Scale
If your printer is color-capable, this option tells GerbTool 
to produce a color print. Otherwise, (if your printer is not 
color-capable) GerbTool produces accurate black and 
white composites, as well as halftone images. When this 
option is disabled, all colors other than the background 
color are printed as black. When enabled, all colors (other 
than black/white) are converted to a different grayscale.
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Fit to page
Specifies that the plot is automatically fitted to the page 
size. 

Overlay
Specifies that GerbTool prints a third color in areas where 
two differently colored objects are superimposed over 
each other. This option applies only if you have a 
color-capable printer.

Print Background
Specifies that GerbTool prints the color for the design 
background. By default, this option is off. 

Sketch
Specifies that GerbTool draws only the outlines for objects 
in the design, rather than filling in those objects.

Window
Specifies that GerbTool prints only that area of the design 
that falls within a user-defined window.

Print 
Select this command when you want to print the viewed 
layers. Use this command to print your design on any 
printer/plotter supported by Windows.

Note Printing background colors uses a 
lot of ink (especially for C-, D-, or E-sized 
designs). Use this option with discretion.
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Print Preview
Use this command to view how each page of your design 
would print before actual printing begins.

Printer Setup
Use the Printer Setup command to select and configure 
the current Windows default printer.

Exit
Select this command when you want to exit GerbTool. The 
current design file can be saved, and you will be 
prompted to confirm that you want to quit if any layers 
have been modified.
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Edit menu
The Edit menu includes these commands: Undo, Select, 
Item, Copy, Move, Delete, Clip, Join, Rotate, Mirror, Scale, 
D-Code, Align Layers, Origin, and Purge.

You can modify the selection criteria for all editing 
commands that require you to modify one or more 
database items. GerbTool commands are flexible in the 
selection of data to modify. For example, you can select 
single items, or items within a window, group, or 
complete layer.

Figure 14Typical selection criteria.

With this dialog box, you can control whether flashes, 
draws, arcs or any combination of all three are selected. 
Further, you can select whether a single item, window, 
group or layer is selected. In Window mode, you can 
select whether to include items that cross the window 
boundary. And finally, you can select whether to restrict 
the selection to a particular layer or D-Code.

You can end any editing command by choosing the right 
button, pressing the E key, or selecting another menu 
item.

For details on using GerbTool shortcut 
keys, see Chapter 4, GerbTool basics. 
Shortcut keys are selected with one 
keystroke and operate immediately, even 
during another command.
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Undo 
Use this command to undo changes you’ve made to the 
currently loaded database. Undo information is saved in a 
last in - first out fashion. This means that you undo changes 
in the reverse order in which the changes were made. This 
allows you to undo the most recent changes first. You may 
also use the shortcut key U to invoke the undo command 
even during another editing command.

Note Undo must be enabled with the Configure command (Options 
menu) prior to making any edits, if you plan to use this command.
Undo increases the amount of memory GerbTool requires. If you do 
not require the undo capability, you may disable undo with the 
Configure command (Options menu). Disabling undo will release 
any memory currently associated with undo information and 
prevent further undo memory use.

Select
Most editing commands (such as Copy, Move, and so on) 
allow you to work with single items, windows of items or 
groups of items. The commands available in the Select 
menu allow you to manage the grouping of items for use 
by these editing commands. When a command allows 
group selection mode, it will use the currently selected 
group created and maintained by the different Select 
commands. Select groups are also persistent from one 
command to another. For example, if you rotate the 
current select group, the rotated data will remain selected 
ready for another command.

The Select menu contains the following commands for 
controlling select groups:
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New Group  
Use this command to start a new group of selected items. 
When you choose this command, GerbTool prompts you 
for confirmation to clear the current select group (if any). 
This does not destroy any data. It simply deselects the 
current select group. If you respond affirmatively, 
GerbTool displays the Group Selection Criteria dialog 
box.

Figure 15Group Selection Criteria dialog box.

Add To  
Use this command to select items and place them in the 
current select group. When you choose this command, 
GerbTool displays the Group Selection Criteria dialog 
box, from which you can choose those items you wish to 
add to the select group.

Remove From  
Use this command to select items and remove them from 
the current select group. When you choose this command, 
GerbTool displays the Group Selection Criteria dialog 
box, from which you can choose those items you wish to 
remove from the select group.
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Invert
Use this command to invert the current select group. That 
is, all currently selected items are deselected and all 
deselected items become selected. One use of this 
command is to allow you to quickly select all but a few 
items by first selecting the items you don’t want and then 
inverting the select group.

Off  
Use this command to clear the current select group and 
remove highlighting from any highlighted items. This 
does not destroy any data. It simply deselects the current 
select group.

Item 
This command displays a floating dialog box you can use 
to edit pertinent information associated with each 
database item. In addition, there are extensive controls for 
navigating from one item to another, including the ability 
locate an item based on its sequential position in the 
database, D-Code, X-Y coordinate, net, and UserData 
value. You can also step forward and backward one item 
at a time using the supplied directional buttons. Lastly, 
you can use the “N” hot key to automatically advance to 
the next item in the database. 

Figure 16Edit Item dialog box.
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The UserData field is of special note, because you can use 
this field to attach textual information to individual 
database items. Any text you associate with your database 
will automatically be saved within your Gerber files the 
next time you save them. This also allows you to pass data 
to other groups in your organization transparently.

An obvious use is to associate actual reference 
designators, pin numbers and net names with each pad 
thereby adding intelligence to your Gerber databases. 
Besides being able to see UserData using the Item 
command (Query menu), macros also have complete 
read/write access to each UserData field. This allows 
some powerful tools to be built upon GerbTool.

Other than a 256-character size limit, there are no 
restrictions on text associated with a database item.

Copy  
Use this command to copy single items, windows, or 
groups of items. By specifying a valid destination layer in 
the Copy to Layer field, you can copy all selected items to 
that layer.

Note If you select data from more than one layer and copy to a 
destination layer, GerbTool merges all into the destination layer. If 
you do not choose a destination layer, GerbTool copies the data into 
the respective source layers.
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Move  
You can use this command to move a single item, a 
window or groups of items. By specifying a valid 
destination layer in the Move to Layer field, you can move 
all selected items to that layer. As with the Copy 
command, if you select data from more than one layer, 
GerbTool merges all moved data into the destination 
layer. If you do not choose a destination layer, GerbTool 
moves the data into the respective source layers.

Delete 
Select this command when you want to delete items from 
one or more layers. You can delete vertices, single items, a 
window or groups of items.

Note If Undo is disabled, you will be prompted for confirmation when 
deleting items.

Clip  
Use this command to specify a window in which 
GerbTool deletes all data with automatic clipping of 
draws that pass through the window. If group mode is 
selected, GerbTool deletes only those items within the 
select group.

Note The On Boundary selection controls whether flashes that straddle a 
window boundary are deleted.
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Join  
Use this command to join two line segments using several 
different methods.

Figure 17Join Parameters dialog box.

Using Normal mode, GerbTool extends or trims the two 
selected line segments as needed so that they connect. 
Naturally, this command will not work for parallel or near 
parallel lines. An option to Normal mode, Trim Second 
Line to First Only, helps when you have a long line in one 
direction and several lines intersecting the long line. With 
this option, GerbTool modifies only the second line you 
select. The remaining modes, Chamfer and Fillet, use the 
Size field to determine how far back to trim each of the 
two selected lines before adding the chamfer or fillet.

Rotate  
Use this command when you need to rotate a window or 
group of items. You can select Window mode or Group 
mode. You can also supply a pivot point (interactive) or 
allow automatic calculation of the center of the data for 
the required pivot point. 

Note If you enter a rotation factor of 90° or 270° and the Auto 90° 
button is selected, Rotate automatically compensates for 
asymmetrical pads, such as rectangles, by replacing the D-Code 
with an equivalent D-Code with opposite dimensions. You can add 
new D-Codes to the appropriate aperture list.
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Mirror  
Use this command if you need to mirror (flip) a group of 
items either horizontally or vertically. You can specify the 
direction to mirror and whether to prompt for the pivot 
point or automatically calculate it. This command can also 
be used to flip a secondary side layer that was designed as 
seen from the primary side.

Scale 
Use this command to apply coordinate offsets and scale to 
a loaded design.

The offsets and scale are applied to the selected layers. By 
applying a scale factor it is possible to expand or shrink 
the size of your database. For example, if you design your 
boards at 2X you can set both the X and Y scale factor to 
0.5 to convert your files to 1X.

Note You cannot “undo” this command. Make sure you save any 
important edits before running this command.

D-Code
The D-Code menu item includes these commands: 
Transcode, Expand, Scale, and Polarity.

Transcode 
Use this command to change the D-Code of an individual 
item, window, group or complete layer. By changing the 
D-Code of an item, you can alter its size and shape. 
Another way to change the size and shape of an item is to 
edit the aperture list directly.
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Expand
Use this command to expand one or all custom apertures 
in a design. This command is required to plot a design that 
contains custom apertures when your photoplotter is 
unable to create the apertures you need. 

When you choose this command, GerbTool asks you for 
the D-Code you want to find. You may enter a specific 
D-Code or you may enter zero to instruct GerbTool to 
expand all custom apertures.

Scale 
Use this command to shrink or expand the size of one or 
more D-Codes. One use of this command is to create 
soldermasks automatically. GerbTool adds new apertures 
to the corresponding aperture list as needed based on 
your specified scale factor. If the Fixed Amount check 
button is enabled, GerbTool adds the scale values to each 
D-Code. Otherwise, each D-Code size is multiplied by the 
scale values specified.

Polarity 
Use this command to control the item level polarity of EIE 
and BARCO format files, as well as FIRE9XXX raster fill 
polygons. When using item level polarity, the ordering of 
the data is crucial. You may find that you need to move 
data “in place,” thereby placing the “moved” data at the 
end of the database.

Note Gerber RS-274-D does not support polarity. Extended Gerber files 
only support polarity at the layer level, which is controlled using the 
Edit command from the Layers menu. FIRE9XXX format only 
supports raster fill polygons at the item level. Otherwise, 
layer-oriented polarity is assumed.
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Align Layers  
Use this command to align any misaligned layers. First 
determine the layer to which all other layers should be 
aligned (the master layer) and select an item to use as a 
reference point. Then select an item, on each layer you 
want to align, that corresponds to the reference point. As 
you select each item, GerbTool automatically aligns the 
entire layer.

Origin  
Use this command to relocate the origin(0,0 point) of the 
database. GerbTool prompts you for a point to define the 
new origin. The film box is moved to the new origin.

Note This command causes GerbTool to mark all layers as modified.

Purge
Use this command to compact the currently loaded 
database for more efficient use of memory. Since 
GerbTool doesn’t actually remove data from memory 
during edits, memory may become fragmented and less 
efficient. Therefore, occasional purging can help GerbTool 
perform optimally.

Note Purging destroys any “undo” information that currently exists. Do 
not use this command unless you are sure you don’t need to undo 
any previous edits.
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View menu
The View menu includes commands to control viewing 
window location and size. 

Window  
Use this command to select a new viewing window. Two 
points are required to define a window. These points 
define a rectangle that encompasses the area that is to 
become the new viewing window. Use this command 
when you want precise control over the viewing window.

Zoom In  
This menu item halves the size of the current viewing 
window using a center point that you supply. This 
command provides a closer look at the displayed data. 

Zoom Out  
Doubles the size of the current viewing window using a 
center point you supply. Use this command to increase the 
size of the viewing window.

Pan  
Moves the current viewing window to a new location. The 
new location is centered about a point you supply. This 
command does not change the size of the viewing 
window.
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All  
This command adjusts the size of the viewing window to 
encompass all of the currently displayed layer(s). If you 
have deleted data from any displayed layers, you may 
need to use the Extents command (Query menu) to 
calculate the current extremes of the database.

Film Box  
Select this command to adjust the size of the viewing 
window to display the contents of the currently specified 
film box. This command does not check to see that all data 
lies within the film box borders. Therefore, depending on 
the film box size, not all data may be displayed. 

Redraw  
This command redraws the current viewing window.

Sketch  
This command toggles sketch mode viewing on and off. 
When sketch mode is enabled, pads are shown with an 
outline only, and traces are displayed as a single thin line. 
Besides speeding up redraw times considerably, this 
mode can also help you identify stacked pads.
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Overlay  
This command toggles overlay viewing mode on and off. 
When overlay mode is enabled, items become transparent 
when drawn atop each other. When disabled, items 
obscure whatever is drawn previously. Overlay mode 
makes it easier to spot stacked pads.

Grid  
This command toggles the grid display on and off. 

Note Grid is also available as a shortcut key by pressing C+g.

Composites  
Enables the correct viewing of composite layers. When 
this button is enabled the polarity of each layer, specified 
by the Polarity field within the Edit dialog box, will be 
honored. If a layer is specified “Clear,” all data in that 
layer is displayed with the current background color.

Virtual Panel
Virtual panel mode (and hence the display of virtual 
panels) may be toggled on and off using this command. 
You can also use the C+v shortcut key. 
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Clear Highlights
This command clears any and all highlights that currently 
exist. Use this command after a command such as 
Highlight (Query menu) or Drill (Tools menu). 

Highlights
This command toggles the display of normal highlights on 
and off. Normal highlights are all highlights not 
indicating a select group or DRC error.

Selections
This command toggles the display of select group 
highlighting. This does not change the actual select group. 
Only the highlight display is changed by this command.
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Errors  
Use this command to view errors after performing a DRC. 
If DRC errors exist, the DRC View Errors dialog box 
appears.

Figure 18DRC View Errors dialog box.

Next
Jump forward to the next non-fixed error.

Prev
Jump back to the next non-fixed error.

GoTo
Jump to the current error, fixed or not.

Print
Print the currently selected error on the default Windows 
printer. The error report includes a screen capture of the 
error and all related information about the error and items 
involved.

Print All
Prints a separate error report for each error in the list.



Chapter 7    Command reference

78

Fixed
Toggles the status of an error. Setting the status to fixed 
allows you to tell at a glance what errors have already 
been corrected.

Highlights
This button toggles the display of the current error 
highlighting. Use this button to temporarily turn off 
highlighting to allow easy correction of the error.

Save
Use this command to save the current viewing window 
for later recall. There are eight positions available, 1-8, for 
saving. The current viewing window is saved in the 
position that you indicate. Use the Recall command (View 
menu) to recall any of the saved viewing windows.

Recall
Use this command to recall a previously saved viewing 
window. If any of the eight possible positions does not 
have a viewing window associated with it, the 
corresponding positions in the menu are disabled. 

Previous
This command recalls the last viewing window. This 
allows you to toggle between two viewing locations.
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Toolbars
This selection presents a menu listing all of the available 
toolbars. You may toggle each toolbar on and off as 
desired.

Split
This command splits the drawing area into multiple 
panes. By dragging the pane dividers to the desired 
location you can have up to four separate viewing panes. 
Each pane may have a different zoom level and/or 
location allowing you to view and edit multiple views of 
your design simultaneously.

Add menu
The Add menu includes commands you can use to enter 
various types of new database items. This menu includes 
the Flash, Draw, Rectangle, Vertex, Circle, Arc Ctr, Arc 3 
Pt, Polygon, and Text commands.

Note GerbTool creates all circles and arcs using circular interpolation or 
multiple line segments, depending on the style indicated by the 
Configure command (Options menu). Use circular interpolation 
with care, as not all photoplotters support circular interpolation. 
Segmented circles and arcs use the chord angle specified using the 
Configure command.

Flash  
Use this command to add a flash to the active layer. 
GerbTool prompts for a point at which to add the flash. As 
you move the cursor about the screen an outline shape of 



Chapter 7    Command reference

80

the current D-Code appears. Choose the left mouse button 
to add a flash at that location.

Draw  
Use this command to draw line segments in the active 
layer. GerbTool prompts you for a starting point and 
subsequent points to form continuous traces. Choose the 
right mouse button or press the E key to start a new 
trace.

Rectangle  
Use this command to draw line segments in the shape of a 
rectangle to the active layer. GerbTool prompts you for a 
starting corner point and an opposite corner point.

Vertex  
Use this command to add (and move by dragging the 
mouse) a vertex anywhere on an existing line segment.

Circle  
Use this command to draw a circle by entering a center 
point and a point on the radius. The circle is drawn on the 
active layer, using the current D-Code, in a 
counter-clockwise direction. 
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Arc Ctr  
Use this command to define an arc by entering a center 
point, a point defining the radius and starting angle, and 
a point defining the ending angle. The arc is drawn on the 
active layer, using the current D-Code, in a 
counter-clockwise direction. 

Arc 3 Pt  
Use this command to define an arc by entering its end 
points and a point on the arc’s circumference. The arc is 
drawn on the active layer, using the current D-Code, in a 
counter-clockwise direction.

Note To create 90° arcs easily and quickly, press the “9” key. This 
automatically constructs a 90° arc.

Polygon  
Use this command to select or enter a closed polygon. 
GerbTool fills or pours the interior of the polygon using 
either a raster fill or vector fill method. This command is 
commonly used to create ground plane areas.

When entering a polygon you can automatically close the 
polygon by pressing the END key. You can also close the 
polygon manually by entering a point at the point that 
began the polygon. 

Regardless of the method, GerbTool then outlines the 
polygon with the current D-Code, as displayed in the 
status bar, and fills the interior of the polygon. In Flood 
Fill mode, GerbTool fills the interior of the polygon with 
increasing aperture sizes. As it fills toward the center of 
the polygon the aperture sizes become larger. 

Note Raster filling is not supported in 
RS-274-D format Gerber files.
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In Pour Around mode, GerbTool fills the interior of the 
polygon, as above, while maintaining clearance, as 
specified by the Draw Clearance and Flash Clearance 
fields, around all circuitry.

Figure 19Polygon Pour dialog box.

Since you can generate many smaller polygons to 
effectively “pour” around the circuitry, you can use the 
Minimum Area parameter to specify the minimum size 
area. GerbTool eliminates any filled areas that would be 
smaller than the specified Minimum Area.

The Pour Around option also supports three additional 
modes: Outline, Solid and Hatch mode.

If you select Outline mode, GerbTool does not fill the 
resultant polygons. You can use this type of output to 
drive PCB prototyping equipment.

If you select Solid mode, GerbTool completely fills the 
resultant polygons using the same methods described for 
the Fill command above.

If you select Hatched mode, GerbTool fills the resultant 
polygons with a cross-hatched pattern, as specified in the 
Hatch Parameters section of the Edit dialog box. Up to 
three lines may be used, with different sizes and angles for 
each line.
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Text  
Use the Text command to insert text into the database as a 
sequence of line segments. You can control the line 
thickness of the inserted text by changing the current 
D-Code. You can also rotate or slant text, and you can 
specify the height and width of the text, along with the 
inter-character and line spacing.

You can select any font from the Font dropdown list. This 
list contains all the TrueType fonts on your system and the 
special “GerbTool-Stroke” font. This special font is 
installed with GerbTool and is a simple font that does not 
use polygonal data or negative polarity.

Following is a list of important points to remember when 
using TrueType fonts:

n TrueType fonts require the use of polygonal data and 
a combination of positive and negative polarity. By 
nature, only RS-274-X, FIRE9000 and EIE file formats 
support negative data and polygonal data.

n GerbTool modifies the layer setup by adding 
additional composite layers. Any previously 
generated report files that specify layer numbers will 
be subsequently out of synchronization.

n Because TrueType fonts require the use of composite 
layers, you must enable composite viewing to view 
the text properly. Although running this command 
enables this mode automatically, you may use the 
View/Composites command to toggle this mode on 
and off.
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GerbTool provides a text editing window in which you 
may enter as many lines of text as needed. You have full 
editing and scrolling capabilities, and can load external 
files and save text files externally. The Text command 
displays the Text dialog box shown below.

Figure 20Text dialog box.
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Layers menu
The Layers menu includes commands for managing the 
individual layers within your design. The menu selections 
include Edit, Colors, Create, and Redline.

Edit  
Use the Edit command to edit layers in your design with 
the Layers dialog box. The effects of editing certain fields 
within the dialog box differ, depending on whether you 
are loading a design or editing after loading.

Figure 21Layers dialog box.
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Within the Layers dialog box you specify:

n The path used to locate the Gerber and aperture list 
files

n Gerber files

n Aperture list files

n Layer names

n Layer visibility

n Flash/draw colors

n Layer type

n File format

n Extended Gerber compositing instructions

While loading, edit the Path field to tell GerbTool where 
to find the specified files if they do not contain a path as 
part of the filename. Entering a wildcard specification (for 
example, *.GBR) in the Filename field displays the file 
chooser. You can choose more than one filename in which 
case all selected filenames are entered in one step. You can 
also enter a wildcard in an Aperture List field to obtain the 
file chooser. If you select a filename, GerbTool enters it in 
the current field.

Note You do not need to fill in the Aperture list field for each specified 
Gerber file. If an Aperture List field is left blank, it assumes the 
contents of the previous Aperture List field. If the Aperture List field 
for the first specified layer is blank then it assumes the currently 
configured default aperture list file.

If you change the Path field after loading, GerbTool marks 
all Gerber and aperture list files as modified. Then, you 
can save them in a location other than the location from 
which you loaded them. 

Changing the contents of a Filename field after a design is 
loaded causes that layer to be marked as modified. Then, 
you can save a layer under a new filename. If you enter a 
filename into a previously empty Filename field, 
GerbTool attempts to load the newly specified Gerber file. 
If it does not exist, you can create it. 
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Changing the contents of an Aperture List field causes 
GerbTool to load the specified aperture list, if it is not 
already loaded, and link it to the corresponding Gerber 
file.

Regardless of whether you are loading or not, the 
Visibility button controls the visibility of the specified 
layer, the Flash and Draw color buttons control the color 
of flashes and draws respectively and the Layer Type 
button displays a menu of layer types from which you can 
choose.

Note It is important to specify the Layer type for each layer, because 
several GerbTool commands check this field for the proper type 
before processing each layer. For example, the Pad Removal 
command (Tools menu) only operates on inner-type layers.

The following is a description of each field within the Edit 
dialog box (from the Layers menu).

Path    Specifies the path to the directory containing the 
Gerber and aperture list files. 

Cut, paste above, and paste below    Use these to 
re-order the layer structure both before and after a design 
is loaded. In addition, if you cut a layer from a loaded 
design without pasting the layer, GerbTool prompts you 
to unload that layer from memory. Then, you can free 
memory if your resources become low.

Layer    Specifies the current layer. To make a layer 
current, click on the layer within the scrollable layer list.

Filename    Specifies the name of a Gerber file loaded into 
the current layer. If you do not include an explicit path, 
GerbTool uses the contents of the Path field to locate the 
file.

Aperture list    Specifies the aperture list file to associate 
with the current layer.



Chapter 7    Command reference

88

Note If the specified aperture list is not already in GerbTool format, it is 
converted automatically.
You do not need to fill in the Aperture list field for each specified 
Gerber file. If an Aperture List field is left blank, it assumes the 
contents of the previous Aperture List field. If the Aperture List field 
for the first specified layer is blank then it assumes the currently 
configured default aperture list file.

Layer name    Specifies a composite layer name used by 
the extended Gerber format files. This is not a filename.

Visibility    Controls the visibility of the specified layer. 
Options are On, Off or Ref.

Flash/Draw    Controls the color of flashes and draws, 
respectively. 

Layer (Type)    Specifies a layer type of Top, Inner, 
Bottom, Plane, Composite, or Other.

Note It is important to specify a type for each layer, because several 
GerbTool commands check this field for the proper type before 
processing each layer. For example, the Pad Removal command 
(Tools menu) only operates on inner layers.

Polarity    Specifies the polarity of layers to form 
composites. Select either Dark or Clear. This field is only 
valid for extended Gerber and FIRE9000 layers.

Link    Links layers together to form composites. Enter a 
numeric value. GerbTool links together layers with 
identical link numbers to form a composite. This field is 
only valid for extended Gerber and FIRE9000 layers.

File format    Specifies the correct data format before 
loading begins. With these buttons, you edit the selected 
layers format, whether global or local, add or remove local 
formats, and automatically detect the format of one or 
more layers.
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Edit    Use this button to edit the file format of the selected 
layer. If that layer has a local format added (the File 
Format Edit button will have Local to its left), the format 
GerbTool displays for editing is specific to the selected 
layer. Otherwise, GerbTool uses the global format. (See 
the File menu’s Format command in Chapter 7, Command 
reference for more information on editing file formats.)

Add Local    Adds a local format to the currently selected 
layer, which you can use to specify that the layer has a 
different format than other layers of the same file type. By 
default, each layer references a global format common to 
all layers of a particular type (for example, Gerber). You 
can use local formats to load different file types into the 
same design. Then you can simultaneously view and edit 
any files in the same design regardless of their file type.

Del Local    Removes a local format.

Detect    Detects the file format of the selected layer and 
updates the format associated with that layer.

The effects of editing certain fields within the Edit dialog 
box differ, depending on whether you are loading a 
design or editing after loading.

Colors
The Colors command displays the Layers Color dialog 
box. Use this dialog box to specify:

n Visibility: ON, OFF or REF

n Draw and Flash Color
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Figure 22Layers Color dialog box.

When a layer is on, indicated by a red box around the 
layer number, it is both visible and editable. When a layer 
is off, it is neither visible nor editable. A black box around 
the layer number indicates that it is the reference layer, in 
which case it is visible but not editable.

Note If you find that you don’t use the reference visibility setting, you 
can disable the availability of the reference status with the 
Configure command (Options menu). 
This command is not available if the ColorBar is visible on the 
window.
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Create  
This command creates a new empty layer with the 
filename TEMP####.EXT, where <####> is the layer 
number and <EXT> is the currently configured extension 
for Gerber files. If you later decide to save the contents of 
this layer you may use the Edit command (Layers menu) 
or the Save command (File menu), using the Save As 
option, to change the filename to something more 
meaningful.

Redline
The Redline command displays a menu with the 
following commands:

n Add Text

n Add Balloon Text

n Add Arrow

n Sketch

n Delete

n Properties

n View Redlining

Use the Redline menu to add comments and other 
information that should be stored separately from normal 
layer information. Every layer may have its own 
associated redline information attached to it.

GerbTool displays redline objects using the current 
redline color and D-Code. If you have not specified these 
settings in the Display dialog box, GerbTool uses the 
default settings.

When you save a design, GerbTool stores redlining 
information in a separate file, located in the same 
directory as the design file. The redline file has the same 
name as the design file, but has a .RED filename extension.
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Add Text  
Use this command to insert text into the currently selected 
layer’s redline file. You can specify text size, rotation, 
slant, mirroring, and spacing. You can also load text from 
an external file and save the text to an external file.

Add Balloon Text  
Use Add Balloon Text to insert a balloon with text into the 
currently selected layer’s redline file. You can specify text 
size, rotation, slant, mirroring, and spacing.

After specifying text you wish to have appear in the 
balloon, you specify where you want the balloon arrow to 
point and the location of the upper-left corner of the 
balloon box. Repeatedly specifying points inserts multiple 
balloons containing the same text.

You can also load text from an external file and save the 
text to an external file.

Add Arrow  
Use this command to insert an arrow of specified location, 
direction, and size into the current layer’s redline file. You 
specify the arrow’s tip first, followed by the tail (which 
indicates the direction and length).

Sketch  
Use Sketch to insert freeform drawings into the current 
layer’s redline file. You can draw lines, curves and other 
shapes, simply by clicking and dragging.
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Delete  
Use Delete to delete items from the redline file.

Properties  
Use Properties to specify the D-Code and color 
to use when adding subsequent redline infor-
mation. Existing D-Code information is not 
affected by changing these properties.

View Redlining  
Use View Redlining to see the associated redline 
information for all of the currently visible layers. When 
this menu item is checked, redlining information appears 
on the screen as well as when printed.
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Apertures menu
The Apertures command displays the Edit, Report, Load, 
Unload, Merge, Compact, Convert, and Save commands.

Edit  
Use this command to edit a previously loaded aperture 
list. A list of currently loaded aperture lists, if such exists, 
appears for you to choose from. GerbTool displays the 
selected aperture list for you to edit.

Figure 23Aperture editing dialog box.

If, after editing an aperture list, you want to discard the 
changes you’ve made, you can choose the Cancel button. 
To keep your changes, at least temporarily, choose the OK 
button. GerbTool updates the in-memory copy of the 
aperture list. To save an aperture list, you must use the 
Save command (Apertures menu).
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The Aperture editing dialog box contains two sections: a 
list for selecting apertures to edit and the actual editable 
fields. The Position field is for reference only and is not 
editable. The nine remaining fields are:

D-Code    Normally, you select a D-Code from the 
apertures list, but you can change this field to add new 
apertures.

Shape    Choose a shape for your aperture. If you choose 
Custom, the Filename field becomes available for you to 
specify the filename of the custom aperture (see 
Chapter 10, Using custom apertures). GerbTool 
automatically adds the required .CUS extension, if 
needed, when loading the custom aperture. If you choose 
Complex, the Filename field becomes available for you to 
specify a valid aperture macro name.

Size X/Size Y    When editing the Size X field, the Size Y 
field, if currently set to 0.0, also assumes the value of the X 
field.

Field Possible values

D-Code 10 - 4095

Shape Round, Square, Rectangle, 
Oblong, Donut, Diamond, 
Octagon, Thermal, Therm45, 
Target, Complex, Custom

Size X 0.0 - 9.9999

Size Y 0.0 - 9.9999

Filename Custom aperture filename or 
aperture macro

Type Surface-mount or 
through-hole

Tool 0 - 999

Tool Size 0.0 - 9.9999

Legend 0 - 4095
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Filename    If the current aperture shape is Custom, enter 
the filename of a custom aperture file. You can use a 
wildcard to invoke the file chooser. If the current aperture 
shape is Complex, enter a valid aperture macro name.

Type    Specifies whether the D-Code represents a surface 
mount or through-hole pad. This information is needed 
when building multilayer netlists.

Tool    Edit this field if you intend to extract NC Drill 
information from a layer, or merge a NC Drill file into a 
layer, using this aperture list.

Size    Specifies the size of the tool indicated in the Tool 
field.

Legend    Used when creating a drill drawing using the 
Drawing command from the Drill menu. You can enter a 
D-Code to represent this tool in a drill legend.

Speed edit    Specifies that GerbTool change the operation 
of this dialog box to make it easier to enter aperture lists 
manually. Normally, when editing an aperture list, 
pressing the J key updates the current aperture and 
advances to the next aperture. When you reach the end of 
the aperture list, new apertures are added automatically. 
Moving from field to field is accomplished using the F 
key or mouse. The Speed edit option activates only the 
Shape and X/Y size fields. Furthermore, the J key 
moves from field to field, except for the Y size field. While 
editing the Y size field, the J key advances to the next 
record, as usual, before moving to the Shape field. This 
change in operation allows fast aperture list creation using 
only the J key to move from field to field and to 
advance to the next record.

Edit AD and Edit AM    These buttons are only active if the 
shape is Complex. Use them to edit the extended Gerber 
aperture definition (AD)  and the aperture macro (AM)  
respectively. For FIRE9xxx aperture lists, use the Edit AD 
button to edit an aperture definition in native FIRE9xxx 
format.
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Search    Use this to search for an aperture that contains 
the text string you specify. You can search for any text 
appearing in the scrollable aperture list. For example, you 
could enter D200 to find that particular D-Code or you 
could enter rect to find the next occurrence of a 
Rectangular aperture. You could also enter .05 to find the 
next occurrence of a 50-mils aperture.

Report  
Select this command to generate an Aperture Report. An 
aperture report details the D-Codes, along with their 
definitions, used on a per layer basis. Included in the 
report are use counts for both flashes and draws.

Note If an aperture has an unknown shape, or is zero in size, GerbTool 
highlights it for easy recognition.

Figure 24Single layer aperture use report.
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Figure 25Combined layer aperture use report.

Generate    Displays a report for the layer specified in the 
Layer field. Entering “all” or “0” in the Layer field 
instructs GerbTool to generate a Combined Aperture 
Report for all loaded layers. Use the scroll bar to view all 
of the report if it does not fit entirely within the window. 
You can edit the report.

Save    Saves the report to a file.

Print    Prints the report to the default Windows printer.

Load
Select this menu item when you need to load or create an 
aperture list. GerbTool prompts you to specify a file. You 
can use a wild card specification to obtain a list of files 
from which to choose. If the specified aperture list doesn’t 
exist, you can create a new one. GerbTool creates an 
aperture list, using default values, then loads it. If you 
specify an existing aperture list, GerbTool simply loads 
the specified aperture list.

Note You may load and edit aperture lists independent of a design.
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Unload
Use this command to remove a previously loaded 
aperture list. GerbTool removes the aperture list you 
select, if it is not required by the currently loaded design. 
If you have modified the aperture but have not saved the 
changes, GerbTool prompts you to do so. 

Merge
Use this command to merge two or more loaded aperture 
lists. GerbTool merges all aperture lists associated with 
the currently viewed layers into a new aperture list. Each 
layer is then associated with the new aperture list. 
GerbTool remaps the D-Codes of each layer accordingly.

Note Save the new aperture list if any remapped layers are saved.

Compact
Use this command to remove unused and redundant 
apertures within an aperture list. Select an aperture list to 
compact. Each layer associated with the selected aperture 
list is then re-associated with the new aperture list and the 
D-Codes remapped accordingly.

Note If you save remapped layers, remember to also save the new 
aperture list.
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Convert
GerbTool has the ability to convert most CAD and 
photoplotter aperture list formats directly into GerbTool 
format. (See Chapter 3, Quick start for a complete list.)

You can specify an input filename and select the 
appropriate converter using the pull-down list.

Save
Use this command to optionally save any modified 
aperture lists.



Query menu

101

Query menu
The Query command displays the Item, Net, UserData, 
Highlight, Measure, Copper, and Extents commands, 
which are described in the following sections.

Item Information  
Use the Item Info command to obtain information on 
individual items within the database. The information 
appears in a dialog box as shown below.

Figure 26Query Item diaplay.

As you select items, GerbTool highlights each item and its 
D-Code definition, along with the X-Y location and other 
information. You can select items with the mouse, or use 
the N key to automatically advance to the next sequential 
item in the database.
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Net  
Use this command to highlight true multilayer nets using 
a variety of colors. Selected nets remain highlighted until 
you specifically clear them.

Figure 27Query Net dialog box.

Query by Mouse, Net or UserData    You can select a net 
at anytime by pressing the left mouse button anywhere on 
a line segment or flash. You can also search for nets by 
their GerbTool net number or their UserData.

Search For    Specifies the net or UserData value for 
which to search.

Find    Choose this button to have GerbTool find and 
highlight the net that contains the value in the Search For 
field.

Clear Highlights    Choose this button to clear any nets 
currently highlighted. This does not change the net; it 
merely removes the highlighting.

Color    This changes the color of subsequent net selections 
when you select a new color. Previous selections are not 
altered.

Add UserData    Once you have a net selected, you can 
globally add a UserData value to all items in the selected 
net. This provides an easy way of assigning meaningful 
net “names” to your nets.

Note This command relies on the netlist information supplied by a 
previous invocation of the Generate command. If a netlist does not 
exist, GerbTool prompts you to create one. 
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UserData  
Use this command to highlight all items that contain a 
specific UserData value. Each selected item remains 
highlighted until you specifically clear the highlighting.

Figure 28Query User Data dialog box.

Search For    Specifies the net or UserData value for 
which to search.

Find    Choose this button to have GerbTool find and 
highlight the net that contains the value in the Search For 
field.

Note For a successful match, the search value can be located anywhere 
within an item’s UserData value. This means that a search value 
“DATA” would match both “DATA32” and “MYDATA.” The 
comparison is not case-sensitive.

Clear Highlights    Choose this button to clear 
highlighting. This does not change any items; it merely 
clears the highlighting.

Color    Changes the color of subsequent net selections 
when you select a new color. Previous selections are not 
altered.
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Measure
The Measure command presents a sub-menu with the 
following selections:

n Point to Point

n Edge to Edge

n Center to Center

Point to Point

Use this command to obtain accurate measurements of 
your data. GerbTool first prompts for a base point from 
which to measure. As you move the cursor away from the 
base point, GerbTool displays the distance in X and Y and 
true length in the prompt area. Choosing the left mouse 
button changes the base point to the current cursor 
position.

Edge to Edge  

This command measures the actual minimum distance 
between two Gerber data items. GerbTool first prompts 
you to select a base item. As you select additional items, 
GerbTool displays the actual minimum distance between 
items in X and Y, as well as true lengths in the prompt 
area.

Center to Center  

Using this command you can measure the actual distance 
between the centers of two Gerber data items. GerbTool 
first prompts you to select a base item. As you select 
additional items, GerbTool displays the actual distances 
between the centers of the items in the X and Y axes, as 
well as true lengths, in the prompt area.
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Highlight  
Use this command to highlight all occurrences of a 
specified D-Code. You can restrict your selection to 
flashes or draws or you can select both. You can also 
specify a particular layer. The selected D-Codes remain 
highlighted until you turn off the highlight with the 
Highlights command (View menu) or “H” shortcut key, 
or when you select another group of items with this 
command.

Copper  
This command accurately calculates the amount of copper 
used on a layer using a high-resolution bitmap method. 
GerbTool scans all visible layers.

Extents  
Use this command to determine the data extents of all 
loaded layers. In addition to displaying the extents 
information, GerbTool also updates its internal data 
extent information. This allows the All command (View 
menu) to correctly center the data after you’ve made edits 
to the database.

By selecting the True Size toggle button, you control 
whether the extents displayed take the true size of each 
database item into account or just their center points.

Selecting the Include Virtual Panelization toggle button 
allows virtual panels to be included in the extents 
calculations also.
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Options menu
The Options command displays the Grid Snap, Ortho Line 
Snap, Arcs 360, Metric, and Configure commands.

Grid Snap  
Use this command to toggle grid snapping on or off. See 
the Configure command (Options menu) for information 
on changing the appearance of the grid.

Note This command is also available as a shortcut key, C+s.

Ortho Line Snap  
Use this command to toggle orthogonal snap mode on or 
off. When enabled, GerbTool forces all lines drawn 
interactively to the specified angle. See the Configure 
command (Options menu) for information on changing 
the snap angle.

Note You can temporarily override the current setting by holding down 
the C key.
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Arcs 360  
Use this command to toggle interpolated arcs on or off. 
This setting affects the method of creating arcs used by the 
Arc Ctr, Arc 3 Pt, and Circle commands (Add menu). If 
enabled, GerbTool creates all arcs using 360° circular 
interpolation. If disabled, GerbTool creates all arcs using 
arcs of 90 or fewer degrees. This does not affect the way 
Gerber data is read from a file. It only pertains to adding 
new arcs with the above mentioned commands.

Note Not all photoplotters support circular interpolation.

Metric  
This menu item toggles metric mode on or off. When 
metric mode is enabled, GerbTool displays all information 
and editing fields that represent sizes and distances (for 
example, coordinates) in metric format.

Configure
Use this command to change GerbTool’s configuration 
and many of the default startup settings. When you 
choose this command, GerbTool displays a tabbed dialog 
box that contains the following topics: General, Display, 
Function Key/Mouse, Ap List Converters, Paths, Files, 
Extensions, User Menu, and Macro Files.

General
This tab displays the current values of various general 
program settings.
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Figure 29General tab.

The New Design Wizard should ignore files with these 
extensions    Enter any filename extensions that you 
know are not used for Gerber or aperture list files. The 
more extensions that GerbTool is able to ignore, the faster 
the New Design Wizard builds a new design file.

Print Border Text    Specifies the text that appears in the 
border of check plots that are generated when printing 
and exporting to HPGL and PostScript. GerbTool looks 
for the keywords $DATE, $TIME, $DESIGN and $PROG. 
If any of these keywords are found, GerbTool replaces 
them with the appropriate text. All other text specified 
appears in the border verbatim.

Text Editor    Specifies the text editor that GerbTool starts 
when you are presented with a file to view or edit.

Max Layers    Controls the number of layers that 
GerbTool can handle. The valid range of values is 12-999. 
Use the minimum value that satisfies your requirements 
in order to conserve memory.

Note This parameter will not become effective until the next time you 
start GerbTool.
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Max Aperture Size    Specifies the maximum aperture size 
that GerbTool creates for filled polygons.

Plane Resolution    Specifies the “Dots Per Inch” 
resolution of the bitmap created when processing a 
power/ground plane during netlist generation. To allow 
maximum speed, keep this value to a minimum. Default 
is 150 DPI.

Chord Angle    Specifies the chord angle used when 
creating segmented arcs using editing commands. For 
example, a chord angle of 5° would result in 18 separate 
line segments for a 90° arc.

Line Snap Angle    Specifies the angle to which lines are 
forced if Ortho Line Snap is enabled.

Flags    Use this field to control some aspects of 
GerbTool’s low-level operations in the field. Typically you 
would be instructed by GerbTool Technical Support 
personnel on how to modify this parameter. The value is 
entered as a hexadecimal number.

Undo    Specifies whether or note GerbTool retains “undo” 
information. If you disable this option, any current 
“undo” information is destroyed.

Layer Ref    Determines whether or not “ref” layer status 
is available. If you find that you don’t use ref status, you 
can disable it by deselecting this box.
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Display
This tab displays the current settings that affect the 
GerbTool window.

Figure 30Display tab.

Grid    Specifies the grid size. You may select a pre-defined 
grid size or enter a value in the size X/Y fields.

Film Box    Specifies the film box size and color. Change 
the current film box size by editing the size X/Y fields. 
Change the film box color by choosing the Color button.

Zoom, Limit or End Cap    Use the Limit field to limit how 
far GerbTool can zoom in. With certain combinations of 
screen resolutions and file formats, the display of items at 
extreme magnification can appear distorted. Use this 
setting to prevent this situation from occurring. The End 
Cap field specifies when GerbTool should stop attempting 
to draw end caps on drawn lines. If the thickness of a line 
(in pixels) is less than or equal to this parameter, no end 
caps will be drawn. Higher values provide decreased 
redraw times at minimum zoom levels.

Note End Cap only affects redraw speed and has no effect on your 
database.
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Highlight Colors    Use these buttons to control the colors 
used when highlighting database items.

Cross Hair    The X and Y fields provide control over the 
size of the drawing area cross hair cursor. Enter 0,0 for a 
full screen cursor.

Background Color    Use this button to change the 
Drawing Area background color. As with all color buttons 
within GerbTool, simply click on the button for a list of 
available colors.

Minimize Redraws    This check box controls whether or 
not GerbTool minimizes the amount of redrawing it does. 
If you are an experienced user you may be comfortable 
redrawing the screen only when you want. 

Note Regardless of this setting, you may always interrupt a redraw, 
without affecting the current command, by pressing the E key.

Function Key/Mouse
This tab displays the current function key/mouse 
command assignments.

Figure 31Function Key/Mouse tab.
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You can change any of the commands assigned to the 
mouse and function keys by selecting from the drop down 
lists. Any changes you make become effective 
immediately after choosing the OK button. This also saves 
the current key assignments so they are available the next 
time you start GerbTool.

Note In addition to command names, you can also program function 
keys with GerbTool Macros, allowing virtually all of GerbTool’s 
power to be within one keystroke.

Ap List Converters
This tab displays a list where you select the aperture list 
converters you require.

Figure 32Ap List Converters tab.

This list shows all aperture list converters found in the 
GerbTool program folder. The current converters are at 
the top of the list with a check mark by them. You can 
select or deselect converters as required. As a general rule, 
the fewer the better. You can also change the title of a 
converter by clicking on an item in the list and then 
clicking on the title. You can then type in a new name. The 
use counts associated with each converter allows 
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GerbTool to try the most popular converters first during 
automatic aperture list conversion. This can speed up the 
process considerably.

Note To add additional .ACR files to GerbTool, copy them into the folder 
specified by the Source Folder field.

Paths, Files, Extensions
This tab displays edit fields for various program default 
values regarding paths, files, and extensions.

Figure 33Paths, Files, Extensions tab.

Aperture Lists    This field tells GerbTool to look for all 
aperture list files, that don’t have an explicit path, in this 
directory. This field replaces the GTMAPDIR 
environment variable used in previous versions of 
GerbTool.

Custom Apertures    This field tells GerbTool to look for 
custom aperture .CUS files in this directory. 

Normal    This field specifies the default aperture list file 
that GerbTool loads if no other aperture list is specified.
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Custom    This field specifies the aperture list used by all 
custom aperture files .CUS loaded. 

Default Extensions    These edit fields specify the default 
filename extensions for the indicated file types. 

User Menu
This tab displays the current user menu configuration so 
you can make changes as desired.

Figure 34User Menu tab.

Label    Use this field to type the menu item label text. A 
character prefixed with the ampersand (&) is considered 
the menu item hot key.

Command    Use this list to select either a macro name or 
command name.

Add    Choose this button to add a new item to the User 
menu. GerbTool uses the current value in the Label and 
Command fields to construct the menu item.
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Remove    Choose an existing menu item in the list, then 
choose this button to remove the item. If you add an item 
and then want to change it, you must remove it and add it 
again.

Macro Files
This tab displays a list of which Macro files you want to 
load the next time you start GerbTool.

Figure 35Macro Files tab.

This list shows all Macro files found in the GerbTool 
program folder. You may select or deselect Macro files as 
required.

Note To add additional Macro files to GerbTool, copy them into the folder 
specified by the Source Folder field.
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Macro menu
The Macro menu includes:

n Run

n Load

n Developer

n Record

Run
This command prompts you to select a macro to run. All 
macros loaded at program startup and through the Load 
command are available.

Load
Use this command to load additional macro files into 
GerbTool. You can include any macros present in the 
specified file in GerbTool’s list of available macros.

Note To have GerbTool automatically load a Macro file at startup, see the 
Configure command described earlier in this chapter.

Developer
This command starts the Macro Developer. If the Macro 
Developer window is minimized, this command restores 
the Macro Developer window, allowing you to edit the 
current macro. If the Macro Developer is not already on 
the screen, you are prompted to select a macro file to edit. 
The selected macro file is loaded into the Macro 
Developer, and displayed on the screen.
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Record
This command toggles the Macro Developer’s record 
mode on and off. When selected, the Macro Developer 
window appears minimized if it is not already restored.

Both the Macro Developer title bar and the presence of a 
checkmark on this menu item indicate that the record 
mode is on. When the record mode is on, user commands 
are automatically captured and recorded to the Macro 
Developer.

After the desired sequence of commands is captured, you 
can stop the recording by choosing Record from the Macro 
menu.

To save the recorded macro

1 Open the Macro Developer by either selecting 
Macro/Edit or by clicking on the Restore or Maximize 
buttons on the minimized Macro Developer window.

2 If desired, change the name of the macro on the 
MACRO line to reflect what the newly created macro 
does.

3 Select File/Save from the Macro Developer’s menu.

To run the macro

1 In the Macro Developer, choose Run Macro from the 
Debug menu, or within GerbTool, choose Run Macro 
from the Macro menu.

2 From the Macro menu, choose Load.

3 From the Macro menu, choose Run.
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Tools menu
The Tools command displays the Panelize, DRC, Snoman, 
Teardrops, Netlist, Test Points, Pad Removal, NC Drill, 
Vent, Convert, Lyr Spread, Fix SS, and Macros commands.

Note GerbTool’s Test Points tool is not available with OrCAD Layout.

Panelize  
The Panelize command creates multiple copies of a design 
in one film box. This allows multiple copies of the design 
to be manufactured as one panel. When you choose the 
Panelize command, GerbTool displays the Panelize/Vent 
Parameters dialog box.

Figure 36Panelize/Vent Parameters dialog box.

Auto Panel    Provides automatic placement of the 
maximum number of copies of the board image, on a 
single panel. 



Tools menu

119

Virtual    Allows GerbTool to panelize your design 
without actually duplicating layer data in the database. 
Virtual panelization provides many benefits, including 
automatic updating of all images during edits and 
drastically reduced file sizes. Further, if you want to plot 
your design on an extended Gerber or FIRE9xxx 
compatible plotter, GerbTool automatically inserts the 
proper step-and-repeat codes into your Gerber data.

Edge to Edge Spacing    (available when Auto Panel is 
selected) The values set the minimum distance between 
adjoining edges of the image copies in the X and Y axes.

Point to Point Spacing    (available when Auto Panel is 
not selected) The values set the minimum distance 
between adjoining edges of the image copies in the X and 
Y axes.

Copies    The values set the number of copies in the X and 
Y axes.

Note Although GerbTool copies only visible layers, all layers of the 
original image remain aligned after panelization.

Minimum Border Spacing    Values set the minimum 
distance between the edges of the image copies and the 
edge of the panel. 

Auto Vent    Defines the shape and placement of flashes 
on the panel outside the image areas. GerbTool adds the 
pattern spacing and aperture selection to the database. 
Automatic venting can occur during panelization, 
regardless of whether or not the panelization is automatic. 
Venting may be targeted to any layers in the Gerber file.

Vent to Image Spacing    Sets the spacing between the 
image copies and the venting area. 

Pattern Spacing    Sets the spacing between the flashes in 
the vent pattern.

D-Code    Sets the size and shape of the flashes.
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To perform manual panelization

1 Activate those layers you want to include in the 
panelization.

2 Select the Panelize command from the Tools menu. 
GerbTool displays the Panelize editing dialog box.

3 Deselect the Auto Panel button.

4 Enter the number of rows and columns in the Copy 
fields.

5 Enter the Edge to Edge and Minimum Border Spacing 
values.

6 Choose the OK button. 

7 Draw a selection box around the area you want to 
copy.

GerbTool previews the panel layout. After asking for 
confirmation, GerbTool completes the panelization 
process. Depending on the setting of the Virtual button, 
GerbTool either copies the proper number of images into 
the database or notes the number of copies and their 
location for display purposes.

To perform automatic panelization

1 Activate those layers you want to include in the 
panelization.

2 Select the Panelize command from the Tools menu. 
GerbTool displays the Panelize editing dialog box.

3 Select the Auto Panel button.

4 Enter the Edge to Edge and Minimum Border Spacing 
values.

5 Choose the OK button. 
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GerbTool automatically calculates the maximum number 
of images that fit inside the current film box, then 
previews the panel layout. After asking for confirmation, 
GerbTool completes the panelization process. Depending 
on the setting of the Virtual button, GerbTool either copies 
the proper number of images into the database or notes 
the number of copies and their location for display 
purposes.

To perform automatic venting

1 Check the Auto Vent button within the Panelize 
editing dialog box.

2 Enter the Vent to Image Spacing values and the 
Pattern Spacing values.

3 Enter the D-Code values. After panelization, GerbTool 
fills the specified area with the defined pattern of 
flashes.

Tip In both automatic and manual venting, the style of vent pattern is 
customized using custom apertures. For example, you can create a 
hatch or cross hatch pattern using a diagonal or cross shape custom 
aperture. Be sure to set the height and width of the overall size of 
the custom aperture in the aperture list.

To perform virtual panelization

1 Activate those layers you want to include in the 
panelization.

2 Select the Panelize command from the Tools menu. 
GerbTool displays the Panelization editing dialog box.

3 Select the Virtual Layers button. GerbTool displays a 
dialog box listing the loaded layers.

4 Select those layers you want to include in the virtual 
panelization and choose the OK button.

5 Proceed with either automatic or manual panelization.
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GerbTool modifies the database with the number of 
copies and their location for display purposes. Virtual 
panel mode (and hence the display of virtual panels) may 
be toggled on or off using the C+v shortcut key. 

GerbTool also inserts step and repeat codes into NC Drill 
output data if you select the Virtual button. This may be 
necessary to drill large panels if your NC equipment is 
memory limited. 

Note Although no data is duplicated during virtual panelization, the data 
origin is modified to center the images within the panel. Therefore, 
it is still necessary to save your design after panelization.
If your designs are plotted on a plotter that does not support 
step-and-repeat codes, you must run the Panelize command 
without the Virtual button selected and save your panelized Gerber 
files before you send them to the plotter.

DRC  
The DRC command checks to see that your design meets 
minimum item to item spacing requirements. When you 
select DRC from the Tools menu, GerbTool displays the 
DRC dialog box.

Figure 37DRC dialog box.
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Report File    This is the file in which all errors are logged. 
Enter a valid filename to set the filename for the DRC 
error file.

Layer    This is the target layer for the DRC. By default, 
GerbTool uses the current active layer in the Layer field. 
You may override this by entering a different layer.

Note If you enter “all” or “0” in this field, GerbTool processes all viewed 
layers.

Highlight Layer    Specifies an optional layer to which 
GerbTool copies all database items that are part of a DRC 
error. That way, you can easily see the whole picture and 
print all errors at once. To disable this feature, enter 
“none” or “0” in this field.

Border Layer    Specifies the layer that contains the design 
border. If you have a layer with just the border on it you 
may specify this layer here. To disable border spacing 
checks, enter “none” or “0” in this field.

Pad/Pad    Specifies the minimum spacing allowed 
between pads.

Pad/Trace    Specifies the minimum spacing allowed 
between pads and traces.

Trace/Trace    Specifies the minimum spacing allowed 
between traces.

Border    Specifies the minimum spacing allowed 
between any item and the border specified in the Border 
Layer field.

Flash    Specifies the minimum pad size.

Trace    Specifies the minimum trace size.

Min Ring    Specifies the minimum annular ring required. 
The Annular Ring option compares the diameter of the 
flash on the DRC layer to the diameter of the flash on the 
drill layer with the assumption that the drill layer 
normally contains a flash at each pad location using a 
smaller size than the DRC layer. The Min Ring value is the 
difference in diameters. 
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Select whether the size of each drill layer flash is taken 
from the D-Code size or the Tool size. Through-hole pads 
that do not have a corresponding drill flash are reported 
as “missing” drills. If either the Min Ring value or drill 
layer are 0, GerbTool does not perform the annular ring.

Tip You can also use the annular ring check to verify a soldermask 
layer. Use the soldermask layer as the active layer; use the copper 
layer on which the pads are defined as the drill layer.

Drill Layer    Specifies the drill layer used in the annular 
ring check. A “0” disables annular ring checking.

Use Size Of    Specifies whether the size of the drill layer 
flashes are taken from the D-Code size or the Tool size 
field within the aperture list when performing annular 
ring checking.

Well Behaved    The DRC command supports two 
separate modes: “well behaved” and normal. In well 
behaved mode, GerbTool assumes that legal pad/trace or 
trace/trace connections have common X-Y locations (see 
the Netlist command in Chapter 7, Command reference for a 
description of well behaved Gerber files). This means that 
any actual contact between items that don’t share a 
common X-Y location, and are in different nets, is 
considered a violation. Conversely, in normal mode, any 
actual contact between items is not considered a violation. 
Only items that are not in contact but are within the 
minimum spacing rules are considered in violation. Well 
behaved mode is preferred if your Gerber files were 
produced accordingly, because it provides much faster 
processing and more accurate results.

Note If a valid netlist does not already exist, GerbTool prompts you to 
generate one. While a netlist is not a prerequisite to DRC, a netlist 
increases the usefulness and accuracy of DRC.

Window    Specifies that GerbTool runs the DRC on a 
particular window of data, rather than on the complete 
layer.

Find Stubs    Allows GerbTool to locate and highlight all 
trace stubs. A trace stub is any trace that touches a pad or 
trace on only one end.
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Max Errors    Sets a limit to the number of errors DRC 
produces. This prevents DRC from generating a huge 
report file if you enter the incorrect spacing rules for a 
given design.

Don’t check items in select group     Tells DRC to ignore 
all items that are in the current select group. For example, 
if you have blocks of text that you want to exclude from 
the check, you can use the Add command to create a select 
group with these blocks of text. DRC then ignores the text, 
thereby producing a much cleaner report.

After performing the DRC, GerbTool enables DRC error 
viewing and displays the DRC View Errors dialog box as 
shown below:

Figure 38DRC view errors dialog box.

You can use this dialog box to examine and document any 
or all DRC errors found. 

Next    Jump forward to the next non-fixed error.

Prev    Jump back to the next non-fixed error.

GoTo    Jump to the current error, fixed or not.

Print    Print the currently selected error on the default 
Windows printer. The error report includes a screen 
capture of the error and all related information about the 
error and items involved.

Print All    Prints a separate error report for each error in 
the list.
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Fixed    Toggles the status of an error. By setting the status 
to fixed you can tell at a glance which errors have already 
been corrected.

Highlights    Toggles the display of the current error 
highlights. Use this button to temporarily turn off 
highlights to allow easy correction of the error.

Use the Errors command to toggle the display of the DRC 
View Errors dialog box.

Note GerbTool updates the DRC report file generated by the last run of 
the DRC command with the fixed status of each error. Therefore, 
you should not remove or substantially alter this file if you intend 
to view DRC errors again using this file.

Snoman
This menu selection starts the Snoman tool. The Snoman 
tool creates a maximum material condition at the point of 
trace entry into a pad. See Appendix C, Snoman concepts for 
a more technical description.

Figure 39Snoman Parameters dialog box

Enter a valid filename in the Rep File field; GerbTool logs 
any errors to this file. You must specify a layer to operate 
on (From Layer) as well as an output layer (To Layer) for 
the generated Snoman pads.
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Note If you enter a zero in the From Layer field, GerbTool processes all 
viewed layers, with the resultant Snoman pads being added to their 
respective layers.

You can restrict the generation of Snoman pads to a 
particular D-Code by entering its identifier in the D-Code 
field. A D-Code of zero matches all.

Edit the spacing parameters to specify the design rules to 
which Snoman must adhere. The Host Offset field 
contains the offset maintained between the host pad 
centroid and the edge of the generated Snoman pad. This 
value may be negative. If Snoman detects a spacing rule 
violation while placing a Snoman pad, it reduces the size 
of the Snoman pad to avoid such errors.

You can control the percentage of the host pad size. Use 
the Min Percent field and Max Percent field to control the 
minimum and maximum size of the generated Snoman 
pad, as a percentage of the host pad size.

You can also indicate whether Snoman should operate on 
a window of data versus a complete layer.

Note If a valid netlist does not already exist, GerbTool prompts you to 
generate one. A netlist is required for the Snoman tool to work 
properly.

Use the Errors command (View menu) to view potential 
rule violation errors, if any, after running this command.

Teardrops
The Teardrop tool creates a maximum material condition at 
the point of trace entry into a pad, or at T junctions for 
traces. That is, when you use the Teardrops command, 
GerbTool adds copper at the point in question to ensure 
that the connection is maintained.
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Figure 40Teardrops dialog box.

Report File    Specifies the file to which GerbTool writes 
any errors for the Teardrops command.

Layer    Specifies the layer that receives the teardrops.

Note If you enter a “0” in the Layer field, GerbTool processes all viewed 
layers.

D-Code    Specifies that GerbTool add teardrops only to 
those pads that use the specified D-Code. A D-Code of “0” 
matches all.

Percent of host    Specifies the relative size of the 
teardrop “tail.” GerbTool calculates this length as a 
percentage of the diameter of the host pad. The value you 
enter can be greater than 100%.

Pad/Trace    Specifies the pad-to-trace spacing parameters 
for teardrops.

Trace/Trace    Specifies the trace-to-trace spacing 
parameters for teardrops.

Length Multiple    Specifies the “T” junction tail length. 
GerbTool calculates this value in multiples of the host 
trace diameter. The value you enter can be fractional.

Width Multiple    Specifies the “T” junction tail width. 
GerbTool calculates this value in multiples of the host 
trace diameter. The value you enter can be fractional.
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Window    When you select this option, GerbTool creates 
teardrops for pads and “T” junctions only within a 
particular window, not for the entire design.

Delete Existing Teardrops    When you select this option, 
GerbTool removes existing teardrops from the design (or 
window within the design) before creating the new 
teardrops.

Note If a valid netlist does not already exist, you will be prompted to 
generate one now. A netlist is required for the Teardrop tool to 
work properly.

All pad locations for which GerbTool could not generate a 
Teardrop are highlighted and their locations are specified 
in the generated report file.

Note You can remove teardrops using the Undo command.

Netlist
The Netlist item displays the Generate and Save 
commands.

Generate  
The Generate command processes all viewed layers and 
creates a single multilayer netlist that becomes part of the 
internal database. The netlist may then be used by other 
GerbTool commands that require a netlist such as DRC 
and Snoman (Tools menu).
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You can indicate whether your database is well-behaved 
or not. A well-behaved Gerber file is defined as a file 
where all items that are to be considered connected share 
a common X-Y location as shown below:

Figure 41Example of a well-behaved Gerber file.

The following illustration shows an example of a Gerber 
file that is NOT well-behaved:

Figure 42Example of a Gerber file that is not well behaved.

If you determine that your Gerber files are indeed 
well-behaved, choose this mode when generating a 
netlist, because there is a dramatic increase in processing 
speed due to the well-behaved nature of the Gerber files.
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Since so many of GerbTool’s features require a netlist to 
perform properly, you can save the generated netlist 
within your Gerber files for later use. If netlist saving is 
enabled, and a netlist is present, GerbTool saves it when 
the layer is saved. To remove a netlist from a Gerber file, 
load the layer (or layers), disable netlist saving using the 
Format command (Files menu) and then save the 
necessary layers.

Note GerbTool uses the G04 command to embed a netlist within a Gerber 
file. This causes the Gerber file to increase slightly in size. Remove 
netlists as described above before submitting your files to be 
photoplotted, due to their increased size and the possibility of the 
photoplot equipment not properly recognizing the G04 command.

Save

This command generates an ASCII netlist file consisting of 
net numbers, or names using UserData, and pad X-Y 
coordinates. This command uses all viewed layers in 
generating the netlist file.

Figure 43Netlist Save dialog box.

Filename    Specifies the desired output filename. Use the 
Browse button to locate the desired output file.

m.n    Specifies the coordinate format.

Renumber Sequentially    Instructs GerbTool to 
renumber the net numbers (if needed) to make sure that 
they are output in order and with no gaps in the net 
numbers.



Chapter 7    Command reference

132

Label Net Using    Provides a means of determining how 
GerbTool labels nets. If your nets have UserData assigned 
to them, you may choose to have your netlist labeled with 
the UserData instead of net numbers.

Note If a valid netlist does not already exist, GerbTool prompts you to 
generate one. A netlist is required for this command to work 
properly.

Fix SilkScreen  
This command automatically removes silkscreen data 
from pads.

Figure 44Fixup Silkscreen dialog box.

You specify the layer that contains the pads (Pad Layer) 
and the layer that contains the silkscreen data (SilkScreen 
Layer), as well as a minimum spacing to be maintained, 
and finally whether you desire window mode. GerbTool 
then removes line segments that violate the minimum 
spacing requirement, as shown in the following before 
and after sequence:
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Figure 45Before running the Fix SilkScreen command.

Figure 46After running the Fix SilkScreen command.

Pad Removal
The Pad Removal command displays the Isolated and 
Stacked commands.

Isolated
Selecting this command removes any unused pads 
(isolated/floating pads) from inner layers.

Note GerbTool considers only inner-type layers. Use the Edit command 
(Layers menu) to change this, if necessary, for a particular layer.

GerbTool does not remove targets or thermal pads. You 
specify the layer from which to remove the pads and 
whether GerbTool processes a window or the entire layer.
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Stacked
Selecting this command removes any unnecessary pads 
that are identical and stacked exactly one on top of 
another on the same layer. You specify the layer from 
which to remove the pads and whether GerbTool 
processes a window or the entire layer.

Drill
The NC Drill command displays the Drawing and Save 
commands.

Drawing
This command creates a drill drawing using the Legend 
field associated with each D-Code in an aperture list.

Figure 47Create Drill Drawing dialog box.

For each D-Code in the From Layer field, GerbTool adds 
the D-Code specified by the corresponding Legend field 
to the layer specified in the To Layer field. Use the 
Copy All option to copy D-Codes with invalid Legends. If 
you select the Copy All option, you can use the 
Sub D-Code field to specify a particular D-Code to use as 
a substitute for invalid Legend D-Codes. If Sub D-Code is 
“0,” all D-Codes with an invalid Legend D-Code use the 
original D-Code value in the To Layer field.
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Save  
The Drill command creates an ASCII output file 
containing X-Y pad locations in the selected NC format. 
GerbTool optimizes the output and removes duplicate 
hits within a single tool.

Figure 48Drill dialog box.

This command relies on the Tool assignments within the 
aperture list for the selected input layer. Optimization is 
controlled by the Swath Width value and by whether an X 
or Y sort is performed. The report file contains an 
approximate distance that the drill head will travel. 
Therefore, by adjusting the swath width and examining 
the report file you can achieve the fastest drilling 
throughput.

Note Perform image panelization prior to executing this command. If 
you perform virtual panelization the output of this command 
contains step and repeat codes. Use these codes if your drilling 
equipment has limited memory capacity. Otherwise, a fully 
optimized non-virtual panel results in more efficient drilling.

Occasionally there may be items that you don’t want 
optimized, but that you want to include in the same drill 
file, such as test coupons and mounting holes. Place these 
items on a layer in the exact order that you want them 
drilled. 
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GerbTool enters these layers into the Merge Layer Pre and 
Post fields. GerbTool inserts these layers into the drill file 
without optimization before and after inserting the 
optimized information from the layer specified in the Drill 
Layer field. This is done on a tool by tool basis. Therefore, 
GerbTool outputs information for tool #1 on the Pre merge 
layer first, then optimizes and outputs the drill layer, 
followed by the tool #1 information from the post merge 
layer. GerbTool then repeats the process for tool #2, and so 
on. 

This also works for Virtual panels when you want to 
include non-panelized drill data.

Sort Tools By - Number or Size    Indicates how 
GerbTool orders the tools in the output file.

Pre-drill holes larger than    Indicates the maximum size 
for holes that will not be pre-drilled.

Convert
The Convert menu item presents a sub-menu with the 
Drawn Pads and Arcs commands.

Drawn Pads  

Use this command to convert pads created with Gerber 
draws into flashes. Use this command prior to attempting 
any other editing or data extraction such as NC Drill. This 
command can significantly decrease the size of your 
database if it contains drawn pads.
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Figure 49Drawn Pad Selection dialog box.

This command prompts you to enter a window around 
the drawn pad you want to convert.

If you select the Create D-Codes check button, GerbTool 
creates new D-Codes as necessary to match the 
dimensions of the drawn pads selected for conversion. If 
you don’t select the Create D-Codes check button, 
GerbTool informs you of the calculated size of the pad as 
shown below:

Figure 50New D-Code dialog box.

Find or create a corresponding flash in the aperture list for 
this layer. Enter the appropriate D-Code in the D-Code 
field and a tolerance value, if needed, in the Tolerance 
field.
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Note The tolerance value allows GerbTool to increase its match frequency 
when the CAD system that generated the drawn pads exhibits 
round-off errors. Usually a value of 0.002 (inches) will suffice.

GerbTool locates and highlights all occurrences of any 
matching drawn pads and prompts you whether or not to 
continue.

Arcs  
This command converts circular interpolated circles into 
segmented circles, individually or by window. Use this 
command if your photoplotter can’t handle circular 
interpolated arcs.

Layer Spread  
Use the Layer Spread command to reduce your film costs 
by automatically copying and spreading all viewed layers 
onto one layer (and thus one sheet of film).

Figure 51Layer Spread dialog box.



Tools menu

139

You can select automatic or manual mode using the 
Layer Spread dialog box as shown above. If you select 
Auto Mode, GerbTool automatically calculates the 
number or images that will fit in the film box as well as the 
position of each image. 

In auto mode the X and Y spacing fields specify the 
opposing border-to-border minimum spacing 
requirements. In manual mode, you must specify the 
number of rows and columns and the center to center 
spacing in the X and Y spacing fields. In either case, you 
can select either Row major or Column major placement. 

While the To Layer field may specify one of the layers to 
be spread, it usually is an empty layer created to accept the 
properly spread out images.

When you choose the OK button, GerbTool prompts you 
to select the order in which the layers are spread. You 
must click on each layer to define the proper order. After 
doing so, GerbTool shows the placement of all layers for 
your approval. If you respond affirmatively, GerbTool 
copies and spreads the layers as shown.
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Vent/Thieving  
Use this command to manually add Vent/Thieving 
patterns to your database. GerbTool displays the 
Vent/Thieving dialog box, in which you can edit the 
venting parameters such as pattern spacing and aperture 
selection.

Figure 52Vent/Thieving dialog box.

You can then define a rectangular area by entering two 
coordinate points. After confirmation, GerbTool fills the 
specified area with a pattern of flashes as specified.



Aperture Conversion Rule 
files

8

In addition to providing the ability to convert most 
popular CAD and photoplotter aperture lists directly into 
the popular GerbTool format, you can create your own 
Aperture Conversion Rule (ACR) files for specialty, 
proprietary or otherwise unsupported aperture list 
formats.
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Definition of an ACR file
An Aperture Conversion Rule (ACR) file is an ASCII file 
that describes a particular aperture list format using 
conversion language statements. Using a text editor, you 
can create your own ACR file that describes the expected 
format of your aperture list. Once it is read in, GerbTool 
can convert your new aperture list format automatically, 
just as it converts the supported aperture list formats (see 
Converting a CAD aperture list on page 9).

Creating an ACR file
An ACR file contains two types of statements. The first 
type describes the environment, such as the expected file 
extension, metric mode, number of header lines to skip, 
and so on. The second type is the actual rule statement, 
which is used to match incoming aperture list entries to 
corresponding GerbTool aperture shapes.

The following are descriptions of the environment-type of 
ACR statements and their expected parameters, if any.

NAME

Syntax NAME converter_name

Parameters

converter_name The name of the ACR file. Should be a 
single word.

Description This statement will place the parameter 
in the header of the resulting aperture 
list.

Example The following example sets the name of 
the converter to ALLEGRO.ACR.
NAME allegro.acr
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VERSION

Syntax VERSION version_number

Parameters

version_number The version number of the ACR file. The 
version number should be a single 
decimal number.

Description This statement will place the parameter 
in the header of the resulting aperture 
list.

Example The following example sets the version 
number of the converter to 6.
VERSION 6

HEADER

Syntax HEADER lines_to_skip

Parameters

lines_to_skip The number of lines to skip in the 
header of the aperture list.

Description If this line is present, the number of lines 
specified will be skipped from the 
header of the aperture list file you are 
attempting to convert. This can be used 
to bypass information at the top of a file 
that you know does not contain any 
apertures.

Example The following example instructs 
GerbTool to skip the first twenty lines of 
the aperture list.
HEADER 20

SKIP

Syntax SKIP skip_string

Parameters

skip_string A text string to mark text to be skipped.



Chapter 8    Aperture Conversion Rule files

144

Description If this line is present, all lines in the 
aperture list that start with the given 
character string will be ignored.

Example The following example will allow 
GerbTool to skip over lines that begin 
with MOIRE.
SKIP MOIRE

DEFAULT_UNITS

Syntax DEFAULT_UNITS mode

Parameters

mode One of $$INCH, $$MIL, or $$MM.

Description If given, will cause the values read in to 
be interpreted as Inches, Mils, or 
Millimeters, depending on the value 
used.

Example The following example sets the units 
mode to metric.
DEFAULT_UNITS $$MM

CUSTOM

Syntax CUSTOM yesno

Parameters

yesno Either $$YES or $$NO.

Description If set to $$YES, GerbTool will attempt to 
create custom aperture names whenever 
possible. Otherwise a Diamond shape 
will be substituted. Note: GerbTool will 
not create the custom apertures 
themselves, only their names in the 
aperture list.

Example The following example sets the creation 
of custom apertures to off.
CUSTOM $$NO



Creating an ACR file

145

EXTENSION

Syntax EXTENSION extension

Parameters

extension The default aperture list extension.

Description The default extension of the aperture 
lists you will be converting with this 
rule file. If the value is entered here, you 
will not need to enter it when specifying 
the aperture list for conversion.

Example The following example sets a default 
aperture list extension of MYA.
EXTENSION mya

DEBUG

Syntax DEBUG mode

Parameters

mode A value of 0, 1, or 2.

Description Enables debugging information to be 
output into the aperture converter’s log 
file. If zero is used, no debug 
information will be output. If 1 is used, 
GerbTool will output debug 
information while parsing the ACR file, 
and if the value is set to 2, debug 
information will be output while 
converting the aperture file itself. This 
function is for advanced users and 
should either not be included or be set 
to zero for normal converter operation.

Example The following example sets the current 
debug mode to 2.
DEBUG 2

XTENSION

Syntax XTENSION dll_filename

Parameters
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dll_filename The name of a .DLL file that you supply.

Description Causes the converter to look for the 
specified .DLL file to help in converting 
the aperture lists.

Example The example specifies a user-supplied 
.DLL.
XTENSION myapfmt.dll

D-CODE

Syntax DCODE mode

Parameters

mode One of $$ONLINE, $$SEQUENTIAL, or 
$$GERBER_ORDER.

Description Controls how D-Code values will be 
derived. If set to $$ONLINE (the 
default) the codes read on each line will 
be used. If $$SEQUENTIAL is used, 
lines that match the rules given will be 
assigned sequential numbers. Some 
aperture lists have their D-Codes 
arranged in a special non-sequential 
order used in certain Gerber 
photoplotters. Walcer will use this order 
if $$GERBER_ORDER is set.

Example The example sets the D-Code mode to 
sequential.
DCODE $$SEQUENTIAL

#

Syntax # any_text

Parameters

any_text The body of a comment.

Description This symbol leads comments in an ACR 
file.

Example The example shows a typical comment.
# Created By A. Designer
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The following is a description of each rule type of ACR 
statement and the expected parameters, if any.

FORMAT_shape

Syntax FORMAT_shape rule

Parameters

shape The possible shapes are: ROUND, 
SQUARE, RECT, OBLONG, DONUT, 
DIAMOND, OCTAGON, THERMAL, 
THERM45, TARGET, and CUSTOM. 
Note that this parameter should be 
combined with the FORMAT_ statement 
to form a single word such as 
FORMAT_ROUND.

rule A rule for matching apertures that are to 
be mapped to a GerbTool shape 
aperture.

Description If the rule matches a line in the aperture 
list being converted, that line will be 
converted into a GerbTool shape 
aperture.

Example The following example will match the 
line: JUNK D10 0.060 0.060 ROUND.
FORMAT_ROUND $skip +D$dcode 
$xsize $ysize ROUND

FORMAT_UNITS

Syntax FORMAT_UNITS rule

Parameters

rule A rule for matching a line in the 
aperture list that specifies the format of 
the file.

Description A line matching this is used to 
determine the format of the aperture 
list. This statement allows the aperture 
list itself to override a previous UNITS 
statement.
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When constructing rules to match apertures, there are 
special keywords that you place in the rule that will cause 
GerbTool to assign the values contained in the fields to the 
corresponding GerbTool aperture list fields. These 
keywords are as follows:

Example The following example will match the 
line: FORMAT MM.
FORMAT_UNITS $skip $units

FORMAT_SPECIAL

Syntax FORMAT_SPECIAL rule

Parameters

rule A rule for matching lines for use by an 
XTENSION DLL.

Description Does not produce a GerbTool D-Code 
line. It is used for special processing by 
an XTENSION-specified DLL.

Example The following example will match the 
line: SQR D10 0.060 0.060.
FORMAT_SPECIAL SQR +D$dcode 
$xsize $ysize

Keyword Meaning

$dcode Assigned to D-Code

$xsize Assigned to xsize

$od Assigned to xsize

$ysize Assigned to ysize

$id Assigned to ysize

$rot Assigned to rotation

$tool Assigned to tool num

$skip Skip this field
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The following is a sample ACR file.

# Aperture converter for Mentor

NAME Mentor

VERSION 1.0

EXTENSION rpt 

# handle swapped X/Y columns

XTENSION mentor.dll

DEBUG 0

CUSTOM $$NO

DEFAULT_UNITS $$INCH

HEADER 1

FORMAT_ROUND $skip +circle +$skip +$xsize 
+$ysize +$rot +false +false +$dcode

FORMAT_THERMAL $skip +circle +$skip +$xsize 
+$ysize +$rot +false +true +$dcode

FORMAT_RECT $skip +rectangle +$skip +$xsize 
+$ysize +$rot +false +false +$dcode

FORMAT_SPECIAL Position +Shape

$custom Use this field to make a custom aperture

$units Used to determine the format of the 
aperture list
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# Mentor now has multiple formats

FORMAT_ROUND  +$skip +$dcode +circle +$skip 
+$xsize +$ysize

FORMAT_THERMAL  +$skip +$dcode +circle 
+$skip +power +$xsize +$ysize

FORMAT_RECT  +$skip +$dcode +rectangle 
+$skip +$xsize +$ysize

FORMAT_SPECIAL Aperture Position



Extended Gerber

9

GerbTool supports the extended Gerber data format 
(sometimes referred to as 274-X) developed by Gerber 
Systems, Inc. (GSI). This format provides for the inclusion 
of aperture data directly in the Gerber data files 
(embedded apertures), flexible aperture definitions and 
easy single file compositing.
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Embedded apertures
Note While it not necessary to understand the syntax of extended Gerber 

to manipulate extended Gerber files within GerbTool, several 
examples of this syntax are provided below. These examples are 
provided to acquaint you with extended Gerber only. See the 
instruction manuals provided with your photoplotter, or contact GSI 
directly, for more information on the extended Gerber syntax.

An extended Gerber file contains all aperture definitions 
necessary to plot the data, thereby eliminating the need 
for an external aperture list. An aperture is defined within 
an extended Gerber file with an AD command as follows:

%ADD<code><macro_name>,<parameter_list>*%

For example:

%ADD10C,0.06X0.020%

This example defines D10 as a simple 60-mils round flash 
using the GSI intrinsic aperture macro “C.”

GerbTool allows you to edit aperture definitions using the 
Edit AD button within the Edit dialog box. See Chapter 7, 
Command reference for more information.

Aperture macros
Aperture macros describe the size and shape of special 
apertures. Using aperture macro primitives, you can 
design complex aperture shapes. Each primitive describes 
a basic shape such as a circle or a line. Each primitive also 
specifies its polarity (on/off) allowing data to be removed 
for such features as donuts or spokes in a thermal. Shown 
below are the different primitives available.
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Aperture macros are also programmable using replaceable 
parameters, which allow a macro to produce different 
results, depending on the aperture definition specified by 
the AD aperture definition command (explained in the 
preceding section). Replaceable parameters are indicated 
by a dollar sign ($) followed by a numeric value. The 
numeric value indicates the parameter’s position within 
the AD aperture definition. A typical donut macro and 
corresponding definitions are shown below.

%AMDONUT*
1,1,$1,0.0,0.0*
1,0,$2,0.0,0.0*
%
%ADD10DONUT,0.60X0.40%
%ADD20DONUT,0.08X0.70%

In the above example, D10 is defined as a 60-mils donut 
with a 40-mils hole, and D20 is defined as an 80-mils 
donut with a 70-mils hole. Note that both D10 and D20 
refer to the same macro but have different sizes.

GerbTool allows you to edit aperture macros using the 
Edit AM button within the Apertures/Edit dialog box. See 
Chapter 7, Command reference for more information.

Table 4 Extended Gerber aperture macro primitives.

Number Type Parameters

1 Circle on/off diameter xcenter ycenter

20 Line-Vector on/off width xbeg ybeg xend xend rot

21 Line-Center on/off width height xcenter ycenter rot

22 Line-Lower left on/off width height xloc yloc rot

4 Outline on/off count x y... rotation

5 Polygon on/off sides xcenter ycenter diameter rot
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Layer compositing
With extended Gerber, a single Gerber file defines a 
composite image of arbitrary complexity. Each “layer” of 
data within the Gerber file is prefixed with an appropriate 
polarity command. Ordering of the layers is critical as the 
data is processed sequentially. For assistance, check the 
example files provided and notice how each layer either 
adds or removes from the initial image.

GerbTool automatically creates separate layers for 
composite layers when reading an extended Gerber file 
and conversely creates a single file for all layers that form 
a composite when writing out data.

Viewing composites
Composite layers can be displayed with the V shortcut 
key. This nested command toggles composite viewing on 
or off. When enabled, GerbTool displays composite layers 
as they are plotted. When disabled, GerbTool displays 
composite layers as if all layers were dark (positive). You 
can also control composite viewing using the Edit dialog 
box.
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Converting from RS-274-D to 
extended Gerber format
In order to convert a set of standard Gerber 274-D files 
into a single extended Gerber composite file, load the 
274-D files as you normally do and then perform the 
following steps using the Edit command (Layers menu):

n Set the Layer Name field of each layer to a meaningful 
name.

n Decide on the filename you want to use for the new 
extended Gerber file and rename all of the Gerber 
filenames to this new name. It is important that each 
extended Gerber “layer” have the same filename.

n Set the Layer Type for each of these layers to 
Composite.

n Assign a polarity and a common number to the Key 
field for each of the extended Gerber “layers.” For 
example, D1 for “Dark composite number 1” or C1 for 
“Clear composite number 1.” A polarity of Dark 
means that the layer is to be displayed in the style a 
normal Gerber file is displayed. Clear tells GerbTool to 
display the layer using the current background color. 
This erases, or “clears,” areas from an image that were 
previously drawn by a “dark” layer. Set negative 
layers to clear.

n Click on the Edit button within the File Format group 
box. Change the Dialect field to extended Gerber 
(274-X).

n Save the composite file using the Save command (File 
menu). All the layers are written into a single 
extended Gerber file with the name that you specified, 
along with an embedded aperture list.

Tip Setting the Layer Name field to the 
original filename of the same layer will 
label the extended Gerber “layers” in a 
fashion that will be familiar to the user.

Note The common number portion of 
the Key field allows GerbTool to load 
multiple extended Gerber composite files 
at the same time. Each set of layers within 
an extended Gerber file should have a 
common number assigned to the Key 
field.
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To load this new extended Gerber composite file into 
another design, enter its filename into the Filename field 
as you would with any other Gerber file, making sure the 
file format has been set to extended Gerber (274-X). There 
is no need to load in an aperture list, because it is already 
included in the file.



Using custom apertures
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Using GerbTool, you can create custom apertures. A 
custom aperture is nothing more than a Gerber file, and 
can therefore be of virtually any size or shape. This 
chapter details the steps for creating a custom aperture.
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Create a custom aperture
n Using the Format command (Files menu), set the 

Gerber format to Inch, absolute, 2.3 and no zero 
suppression.

n Select the Load command (Files menu).

n Enter the appropriate design filename.

n In the Layers dialog box, enter a descriptive name in 
the Filename field, such as FIDUCIAL.CUS (the .CUS 
extension is mandatory).

n Enter the filename of the aperture list that you will be 
using for this custom aperture in the Aperture List 
field.

n Choose the OK button. GerbTool will inform you that 
the specified Gerber file doesn’t exist. Respond 
affirmatively to create the new layer.

n At this point you can create your custom aperture 
using any of the apertures defined in the aperture list 
assigned to the new layer.

To use the new custom aperture, enter its filename 
(without an extension) in the Shape field of an aperture list 
using the Edit command (Apertures menu). 

Note The aperture list used while designing your custom aperture must 
be specified in the Custom Ap List field within the Defaults dialog 
box. Use the Defaults command (Options menu) to change this 
field, if necessary. An aperture list used for custom apertures 
should not itself contain any custom apertures.

Tip For best results, you should set aside one aperture list dedicated to 
all your custom apertures.

Tip Use one design file for all of your 
custom apertures.

Note Before you save your custom 
aperture, ensure that the origin is where 
you want it. You can use the Origin 
command (Edit menu) to relocate the 
origin.



Working with text fonts

11

GerbTool uses a font file containing a list of X-Y 
coordinate pairs that constitute the “strokes” required to 
display each character inserted by the Text command 
(Edit menu). You can have more than one font file but 
GerbTool will always read the STROKE.FNT file at 
startup. To use a different font file, rename STROKE.FNT 
to some other name, then rename your font file to 
STROKE.FNT. GerbTool allows you to edit existing fonts 
and create new fonts that are used for text insertion. This 
chapter details the steps for editing fonts.
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Editing a font
Before you edit a font you must convert it into individual 
Gerber files for each character. To do this, from the system 
prompt change to the GerbTool fonts directory and type 
the following command, then press the J key:

f2g ../stroke.fnt

This will create an individual Gerber file for each 
character in the font file. You can now start GerbTool and 
load one of the provided design files UPCASE.GTD, 
LWCASE.GTD, NUMBERS.GTD, PUNC1.GTD, or 
PUNC2.GTD, which cover uppercase, lowercase, 
numbers, and punctuation characters respectively. The 
Film Box is set to a 7-mils square, in which each character 
must remain. You can draw any shape you want as long 
as you stay in or on the film box and you don’t try to add 
flashes.

Note It is important that the file format of the individual Gerber files for 
each character remain at Inch, absolute, 2.3, and no zero 
suppression.

Once you have finished editing the characters, you can 
use the following command at the system prompt to 
create a new font file, then press the ENTER key.

g2f newfile.fnt

In the above example, a new font file would be created 
with a filename of NEWFILE.FNT. Note that this program 
does not purge the individual Gerber character files. You 
may do this manually if you want. Remember that 
GerbTool will not recognize your new font file unless it is 
named STROKE.FNT and is in the GerbTool PROGRAM 
folder.
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Creating a new font
To create a completely new font you can follow the steps 
detailed in Editing a font above, but skip the font file to 
Gerber file conversion step.

Note It is usually easier (and faster) to modify an existing font than to 
create one from scratch.
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Command ID values

A

The tables in this appendix contain the command ID 
values associated with each GerbTool command. You can 
use these values to program your mouse and function 
keys.

Table 5 Command ID values.

Command ID

Compact (Apertures menu) AO

Convert (Apertures menu) AV

Edit (Apertures menu) AE

Load (Apertures menu) AL

Merge (Apertures menu) AM

Report (Apertures menu) AR

Save (Apertures menu) AS

Unload (Apertures menu) AU

Arc 3 Pt (Add item, Edit menu) EAA3
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Command ID

Arc Ctr (Add item, Edit menu) EAAC

Circle (Add item, Edit menu) EAC

Draw (Add item, Edit menu) EAD

Flash (Add item, Edit menu) EAF

Polygon (Add item, Edit menu) EAP

Rectangle (Add item, Edit menu) EAR

Text (Add item, Edit menu) EAT

Vertex (Add item, Edit menu) EAV

Align (Edit menu) EA

Clip (Edit menu) EK

Copy (Edit menu) EC

Expand (D-Code item, Edit menu) EDE

Polarity (D-Code item, Edit menu) EDP

Scale (D-Code item, Edit menu) EDS

Transcode (D-Code item, Edit menu) EDT

Erase (Edit menu) EE

Item (Edit menu) ET

Mirror (Edit menu) EI

Move (Edit menu) EM

Origin (Edit menu) EO

Purge (Edit menu) EP

Rotate (Edit menu) ER

Add (Select item, Edit menu) ESA

Invert (Select item, Edit menu) EPI

New (Select item, Edit menu) ESN

Table 5 Command ID values. (continued)
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Command ID

Off (Select item, Edit menu) ESO

Remove (Select item, Edit menu) ESR

Undo (Edit menu) EU

Chgdir (File menu) FD

Close (File menu) FC

Exit (File menu) FQ

BARCO DPF (Export item, File menu) FEB

IPC-D-350 (Export item, File menu) FE350

IPC-D-356 (Export item, File menu) FE356

Drill (Format item, File menu) FFD

Gerber (Format item, File menu) FFG

Load (Format item, File menu) FL

BARCO DPF (Import item, File menu) FIB

Drill (Import item, File menu) FIN

HPGL (Import item, File menu) FIH

IPC-D-356 (Import item, File menu) FI356

Design (Merge item, File menu) FMD

Gerber (Merge item, File menu) FMG

Auto (New item, File menu) FNA

Manual (New item, File menu) FNM

Open (File menu) FO

HPGL (Plot item, File menu) FPH

PostScript (Plot item, File menu) FPP

Print (File menu) FP

Save (File menu) FS

Table 5 Command ID values. (continued)
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Command ID

Colors (Layers menu) LC

Edit (Layers menu) LE

Arcs 360 (Options menu) OA

Bg Color (Options menu) OB

Defaults (Options menu) OD

Filmbox (Options menu) OF

Grid (Options menu) OG

KeyCmds (Options menu) OK

Metric (Options menu) OM

Ortho (Options menu) OR

Overlay (Options menu) OO

Save (Options menu) OV

Show Errs (Options menu) OE

Sketch (Options menu) OS

Undo (Options menu) OU

Copper (Query menu) QC

Extents (Query menu) QE

Dcode (Highlight item, Query menu) QHD

Net (Highlight item, Query menu) QHN

Off (Highlight item, Query menu) QHO

Item (Query menu) QI

Edge to Edge (Measure item, Query menu) QME

Point to Point (Measure item, Query menu) QMP

Circles (Convert item, Tools menu) TCA

Pads (Convert item, Tools menu) TCP

Table 5 Command ID values. (continued)
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Command ID

DRC (Tools menu) TD

Fix SS (Tools menu) TF

Lyr Spread (Tools menu) TL

Load (Macro item, Tools menu) TML

Run (Macro item, Tools menu) TMR

Drawing (NC Drill item, Tools menu) TNDD

Write (NC Drill item, Tools menu) TNDW

Generate (Netlist item, Tools menu) TNLG

Write (Netlist item, Tools menu) TNLW

Isolated (Pad Removal item, Tools menu) TPI

Stacked (Pad Removal item, Tools menu) TPS

Panelize (Tools menu) TP

Snoman (Tools menu) TS

Vent (Tools menu) TV

All (View menu) VA

Errors (View menu) VE

Filmbox (View menu) VF

Pan (View menu) VP

Previous (View menu) VV

Recall (View menu) VC

Redraw (View menu) VR

Save (View menu) VS

Window (View menu) VW

Zoom In (View menu) VI

Zoom Out (View menu) VO

Table 5 Command ID values. (continued)
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Table 6 Command ID values assignable to mouse buttons.

Command ID

All (View menu) VA

Film Box (View menu) VF

Pan (View menu) VP

Previous (View menu) VV

Redraw (View menu) VR

Window (View menu) VW

Zoom In (View menu) VI

Zoom Out (View menu) VO



Aperture list file format

B

This appendix describes the format of a GerbTool 
aperture list and provides an example of an aperture list.

Aperture lists are stored as simple ASCII files. There are 
nine fields in each line of the file. Each line defines one 
D-Code. The fields consist of the following:

Table 7 Aperture list field definitions.

Field Possible values

D-Code 10 - 4095

Shape Round, Square, Rectangle, Oblong, Donut, 
Diamond, Octagon, Thermal, Therm45, 
Target, Complex, or a filename prefixed by a 
“%”

Width 0.0 - 9.9999

Height 0.0 - 9.9999
When referring to Donuts or Thermals, this 
field represents the diameter of the inner hole. 
When referring to Targets, it refers to the 
diameter of the inner ring of the Target.



Appendix B    Aperture list file format

170

All fields are separated by white space. Lines that begin 
with a “#” are treated as comments. Although the author 
and data comments are not required, they are generally 
included as an aid for other users. The header of a 
GerbTool aperture list may contain a format line preceded 
by a “%.” This line contains either IMPERIAL or METRIC 
followed by a version number. If IMPERIAL is specified, 
all sizes are in inches. If METRIC is specified, they are in 
millimeters. If no format line is provided, IMPERIAL is 
assumed. The version number is for documentation 
purposes only. An excerpt from an aperture list showing 
the required format follows.

Field Possible values

Type SM (surface-mount) or TH (through-hole)

Tool 0 - 999
Specifies the Tool used to drill this D-Code.

Tool Size 0.0 - 9.9999
Specifies the size of the above Tool number.

Legend 10 - 4095
Specifies the D-Code to use in place of this 
D-Code when creating a Drill Drawing using 
the Drawing command from the Tools>Drill 
menu.

R90 10 - 4095
Specifies the D-Code to substitute for this 
D-Code when rotating 90 or 270 degrees. This 
field exists only for compatibility with older 
versions of GerbTool, as newer versions 
perform the D-Code substitutions 
automatically.

Table 7 Aperture list field definitions. (continued)
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Figure 53 Sample aperture list file.

In the above example, D26 is specified as a Custom 
aperture with a filename of FIDUCIAL.CUS. The “%” is 
required, to notify GerbTool that what follows is a custom 
aperture filename.

# Format, Version
%IMPERIAL, V3.0
#

# Author: GerbTool V1.0 (c) 1992 WISE 
Software Solutions, Inc.
# Date:   Wed Oct  7 13:28:46 1992
#
#    Shape     Width  Height Type Tool  
Size Legend R90
#
D12  Round     0.0100 0.0100 TH   0     
0.0  0      0

D21  Square    0.0200 0.0200 TH   2     
0.0  0      0

D22  Rectangle 0.0220 0.0180 SM   3     
0.0 85      0

D23  Oblong    0.0220 0.0180 TH   3     
0.0  0      0

D24  Diamond   0.0240 0.0240 TH   4     
0.0  0      0

D25  Target    0.1800 0.1600 TH   0     
0.0  0      0

D26  %FIDUCIAL 0.0000 0.0000 TH   0     
0.0  0      0

D70  Octagon   0.0240 0.0240 TH   5     
0.0  0      0

D71  Thermal   0.0240 0.0200 TH   0     
0.0  0      0
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Snoman concepts

C

Snoman creates a maximum material condition at the point 
where a trace segment enters a pad, thereby eliminating 
the possibility of pad/trace separation (breakout). This is 
accomplished by examining a Gerber file (layer) and 
outputting pad flashes at the correct locations, and of the 
correct size, to provide the most material where a trace 
enters a pad. Automatic adjustments are made to the size 
and location of the generated Snoman pads to eliminate 
design rule spacing violations.

The illustration in Figure 54 shows the original pad and 
trace, as well as the resultant Snoman pad.
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Figure 54 Snoman concept.

The distance maintained between the host pad center and 
the edge of the generated Snoman pad (see Host Offset in 
illustration above) is adjustable. Negative values allow the 
Snoman pads to closely hug the host pads.

Host pad Snoman pad

Host offset Trace



Glossary

absolute mode When all X-Y coordinates are referenced to a common 
origin (0,0).

active layer The layer that all items added to the database are placed 
on.

aperture list A list of Gerber D-Code definitions.

block size The size of a coordinate value in characters. Also known 
as m.n format.

breakout Pad and trace separation during fabrication.

design file A file containing information about the layer structure of 
a single PCB design. This file also stores various 
information about the GerbTool operating environment.

DRC Acronym for Design Rules Check.

incremental mode When each X-Y coordinate is a displacement from the 
previous coordinate.

isolated pads Pads that do not have a trace connected to them.

NC drill Refers to files produced to drive Numerically Controlled 
drilling machines.

netlist A file that describes how various pads in the design are 
connected together by tracks. Sets of pads connected in 
common are referred to as nets.
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pad removal The act of removing isolated or stacked pads.

pan Moving the location of the viewing window without 
changing its size.

panelize Placing multiple copies of a PCB on one piece of film. The 
multiple copies are then manufactured on a single panel, 
thereby reducing manufacturing costs.

point An X-Y location within the drawing area.

virtual memory A combination of hardware and software that allows an 
application to address all memory that the CPU is capable 
of addressing, even when there is less actual memory. The 
virtual memory manager swaps data back and forth to the 
disk and remaps memory addresses to provide 
applications with virtually unlimited memory. Available 
disk space becomes the limiting factor.

wildcard specification A method of specifying more than one filename at a time. 
Use the asterisk (*) character to match any character or 
group of characters. Use a question mark (?) to match a 
single character. For example: *.GTD represents all files 
that end with the .GTD extension.



Index

A
active layer, 27
add

arc, 89
arc 3 pt, 89
circle, 88
draw, 88
flash, 87
polygon, 89
rectangle, 88
text as line segments, 91
text as redline information, 100
vertex, 88

aligning layers, 40, 80
annular ring, 131
aperture conversion rules

#, 154
CUSTOM, 152
DCODE, 154
DEBUG, 153
DEFAULT_UNITS, 152
EXTENSION, 153
FORMAT_shape, 155
FORMAT_SPECIAL, 156
FORMAT_UNITS, 155

HEADER, 151
NAME, 150
SKIP, 151
VERSION, 151
XTENSION, 153

aperture list
compacting, 107
converting, 17, 108
create, 106
editing, 102
embedded, 159
files, 30
format, 177
load, 106
merging, 107
saving, 108
unloading, 107
use report, 105

apertures
custom, 103
definition, 104
macro, 103–104, 160
maximum size, 117

arcs
chord angle, 117
conversion, 146
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interpolated, 27, 115

B
background color, 119
BARCO DPF

export, 62
import, 56

birdseye view, 24
breakout, 181

C
calculating

copper, 113
data extents, 113

chord angle, 117
color list file, 14
command ID, 171
compacting aperture list, 107
composite layers, 42
composite layers 274-X, 96
composites, 274-X, 162
composites, viewing 274-X, 83, 162
configuration, 13
configure

aperture converters, 120
function keys, 119
macro files, 123
mouse, 119
paths, 121
user menu, 122

conversion
aperture lists, 30
arcs, 146
drawn pads, 144
RS-274-D to 274-X, 163

converting aperture list, 108
coordinate display, 28
copper calculation, 113
copying, 75
creating

a soldermask layer, 46
NC Drill files, 40

crosshair
cursor, 29
size, 119

D
data extents calculation, 113
D-Code

expand, 79
highlight, 113
polarity, 79
scale, 79
transcode, 47, 78

deleting, 76
deleting with clipping, 76
design

closing, 52
creating, 50–51
merging, 55
opening, 51
save, 52
save all, 52
save as, 52

design file
creating automatically, 19
creating manually, 20
open, 21, 51
saving, 52

designs, merging, 43
destination layer

copying, 75
moving, 76

drawing
area, 24, 29
interrupting, 34, 36

drawn pads, 44
conversion, 144

DRC, 130
annular ring, 131
keepouts, 133
missing drill, 132
stubs, 132
view errors, 133
well behaved, 132

DXF
export, 62
import, 58

E
edit item, 74
editing

aperture list, 102



Index

179

layers, 93
ending a command, 34
exiting GerbTool, 22, 24, 70
export

BARCO DPF, 62
DXF, 62
HPGL, 64
IPC-D-350, 62
IPC-D-356, 62
PostScript, 66

F
file format

critical, 58
global, 53
local, 53, 97
metric, 54

film box, 29
change, 118

fonts
creating, 169
editing, 168
TrueType, 91

function key
assignments, 31
macro, 119

G
Gerber dialect

274-X, 53
EIE, 53
FIRE9xxx, 53

Gerber files, 30
grid

change size, 118
display, 26, 83
snap, 26

group selecting, 72
GTMAPDIR, 121

H
highlight

clear, 84
colors, 119
D-Codes, 113

nets, 110
selections, 84
toggle, 84
userdata, 111

HPGL
export, 64
import, 56

I
import

BARCO DPF, 56
DXF, 58
HPGL file, 56
IPC-D-356 netlist, 57
NC Drill file, 58

information, redline/markup, 99
IPC-D-350 export, 62
IPC-D-356

export, 62
import, 57

isolated pad removal, 141
item editing, 74
item information, displaying, 109

J
joining lines, 77

L
layers

aligning, 80
alignment, 40
color and visibility, 97
color, floating, 24
composite, 42
create, 99
editing, 93
maximum, 116
path, 94
rearranging, 95
ref mode, 117
save, 52
save all, 52
save as, 52
spread, 146
visibility, 95
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lines
chamfer, 77
fillet, 77
joining, 77

M
macro

edit, 124
function keys, 120
load, 124
record, 125
run, 124

measuring
center to center, 112
edge to edge, 112
point to point, 112

merging
aperture list, 107
design file, 43, 55
Gerber file, 55
HPGL file, 56

metric mode, 27, 115
mirroring, 78
mouse button assignments, 31
moving, 76

N
NC Drill, 30

creating, 143
drawing, 142
tools, 104

NC Drill file
creating, 40
import, 58

netlist
generate, 137
highlight, 110
saving, 139
well behaved, 138

netlist information, saving, 55

O
offsets, applying, 78
operating environment, 30
origin, 80

ortho, line angle, 117
orthogonal mode, 27, 114
overlay mode, 25
overview, 15

P
pad removal

isolated, 141
stacked, 142

page setup, 67
panelize, 126

virtual, 143
panelizing, 42
panning, 81
plotting

HPGL batch mode, 65
HPGL borders, 64
HPGL interactive mode, 65
Page Setup batch mode, 68
Page Setup borders, 68
PostScript batch mode, 67
PostScript borders, 67
PostScript composite, 67

polygon
filling, 89
pouring, 89

PostScript, export, 66
print preview, 70
printer setup, 70
printing, 69
programming

function keys, 37
mouse buttons, 37

purging, 80

Q
query

database information, 109
nets, 110
userdata, 111

R
redline information, 99
redraw, minimize, 119
rotating, 77
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rule violation, displaying, 26, 85

S
save, 52
save all, 52
save as, 52
saving, aperture list, 108
scale

database, 78
D-Codes, 79

selecting groups, 72
selection criteria, 71
settings, current, 25
shortcut keys, 32, 36
silkscreen, automatic cleanup, 45, 140
sketch mode, 25
Snoman, 48, 134
soldermask layer, creating, 46
split screen, 24
starting GerbTool, 16
status bar, 29
step and repeat, 143
surface-mount pads, 104

T
teardrops, 135
text as line segments, 91
text as redline information, 100
thieving, 148
through-hole pads, 104
tool tips, 25
toolbar, 24
transcode, 47

U
Undo, 72
undo, 37

toggle, 117
unused pad removal, 141
userdata

editing, 75
highlight, 111

V
vent, manual, 148
view

all, 82
birdseye, 28
composites, 26, 83
errors, 26, 133
film box, 82
grid, 83
new window, 81
overlay mode, 83
panning, 81
previous, 86
recall, 86
redrawing, 82
save, 86
sketch mode, 82
split, 87
split screen, 28
toolbars, 87
virtual panel, 83
zoom in, 81
zoom out, 81

W
well behaved

DRC, 132
netlist, 138

wizard, new design, 50, 116

Z
zero suppression, 54
zooming in, 81
zooming out, 81


